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CoLLIGO ENGAGE

Colligo Engage provides a complete solution for managing SharePoint enterprise content including
emails, documents and other types of content. Colligo Engage tightly couples Colligo Engage Outlook
App and Colligo Engage Windows App so users can seamlessly file, tag, sync, view, share and find
SharePoint content on Windows PC/laptops anytime, anywhere.

Colligo Engage Interfaces

Colligo Engage consists of two products bundled together: Colligo Engage Outlook App and Colligo
Engage Windows App for Windows.

Colligo Engage Outlook App Interface

Because Colligo Engage Outlook App is an Outlook add-in, you are launching Colligo Engage when you
launch Outlook. In Outlook, the Colligo Engage functionality displays in the Home tab ribbon:

; i;“ 4 Search
i ] F =i .

i Colligo~
Mowve Copy

Colligo Engage

And in the Outlook folder tree:

4 Favorites
Inbox
Sent ltems

Deleted Items 814

4 Colligo Engage
Deleted Items
Browser

I Favarites

I Folders

I» Recovered Items

Search Folders

The other part of Colligo Engage Outlook App is the Sync Panel. This is a separate program that displays
in its own window. From here you can configure options and see any syncissues such as conflicts or files
being locked.

To display the Synchronization Panel, open Colligo Engage from your Start menu or from the system tray
icon:
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- = i B
@‘ Colligo Engage Sync Panel lilglg
File Site View Help
Sync Issues
Issue Item site List Folder
: | 2
E@Nc Synchronization Activity

Colligo Engage Windows App Interface

Colligo Engage Windows App consists of a core, stand-alone product interface and a Windows Explorer
extension. Depending on your preference, you can use one or both interfaces as the functionality is
essentially identical. le. You can perform an action in one interface and the other will reflect the change.

The stand-alone product is launched from the Start menu or from the system tray icon and displays as

follows:

=
©) Colligo Engage

File Site View Help

Site: [y <MNo Sites>

3

- | zsknchrorﬂze... x| W

Mew ~ | Upload ~ | Filter =

I@ No Synchronization Activity A

The Windows Explorer extension displays as Colligo Engage under the Computer node:
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CoLLIGO ENGAGE OUTLOOK APP

Welcome to Colligo Engage Outlook App, the simple, powerful, and reliable solution to enterprise email
management in Microsoft SharePoint. Featuring seamless integration with Microsoft Outlook, Colligo
Engage Outlook App makes it fast and easy to file, tag, find, view, sync and share email and attachments
in SharePoint, all from within the familiar Outlook interface.

Colligo Engage Outlook App streamlines SharePoint interaction by providing simple, intuitive ways to
move or copy email and attachments to SharePoint from Outlook, including drag-and-drop or send-and-
file. Email metadata is automatically captured for findability, and additional metadata can be easily
added to classify content according to corporate guidelines or regulatory requirements. The integrated
search functionality searches both SharePoint and Outlook to locate emails, or find documents to send
as attachments. SharePoint sites can also be viewed from within Outlook, making finding content a
breeze.

Colligo Engage Outlook App also encourages users to file emails and attachments to SharePoint in the
office or on the road, and allows mobile and remote workers to remain productive, regardless of network
latency or unavailability.

Key Features

o File—Drag-and-drop email and attachments to SharePoint within Outlook, using the familiar Out-
look folder tree. Send & File button automatically files sent email to SharePoint.

o Tag—Add automatic or customized metadata, including managed metadata.

¢ Sync—download SharePoint content for offline viewing and editing. File emails even when dis-
connected from the network.

e Find —Search Outlook and SharePoint together. Find your content no matter where it lives.

e View —See SharePoint content right inside Outlook. No need to switch to the browser.

o Share —Email attachments as links for easy collaboration.

o Deploy —Deploy easily, client-only installation.

Benefits

e Empower users to easily manage email & documents in SharePoint

¢ Increase the quantity of content captured & tagged in SharePoint

e Reducerisk, improve compliance & records retention

e Reduce uncontrolled content in personal archives and PSTs

o Make SharePoint accessible in the applications users use every day, everywhere

¢ Improve collaboration, document & project management

e Drives user adoption of SharePoint by improving ease of use

e Encourage users to file emails and attachments to SharePoint in the office or on the road

¢ Allow mobile and remote workers to remain productive, regardless of network latency or unavail-
ability

Platforms Supported
e Microsoft Outlook 2007, 2010 SP1, or 2013 (32-bit or 64-bit edition)
Microsoft SharePoint 2007, 2010, or 2013
Windows Vista, Windows 7, or Windows 8
Internet Explorer 7, 8, or 9 (optional)
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NOTE: The screenshots in this document use Outlook 2013, SharePoint 2010, and Windows 7. Your user
interface may differ depending on your specific configuration.
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INSTALLING AND ACTIVATING COLLIGO ENGAGE OUTLOOK APP

To install and activate Colligo Engage Outlook App:

NOTE: if you have already activated Colligo Engage Windows App, you do not need to activate Colligo
Engage Outlook App. See Installing and Activating Colligo Engage Windows App.

1. Double-click to open the Colligo Engage Outlook App XX.zip file and extract the contents.
2. Inthefolder, double-click the folder that corresponds with your operating system:
a. x86: choose this option if you have a 32-bit operating system
b. x64: choose this option if you have a 64-bit operating system
4. Double-click Setup.exe.
Follow the steps in the install wizard.
6. Afterinstallation is complete, enter your information to activate the software. If you do not activate
Colligo Engage Outlook App, it does not display.
7. Ifyou are unable to connect to the activation server, the following error message displays:

(€ Colligo Engage [ﬁJ

v

To complete your installation, please complete the fields below and click
Activate. Your privacy is important to us, and your personal infarmation will
never be shared with third parties.

Narme: David Jackson
Organization: Firestarter
Email address: djackson@firestarte r.con"l

&3 Unable to connect to the activation server. Please try again later
or activate by email.

| Activate || ActivatebyEmail || Exit |

- 4

NOTE: The inability to connect could be due to firewall settings in your corporate network or a
dropped internet connection. If the connection issue is temporary, Colligo advises to attempt
activating at a later time before trying activation by email.

8. Click Activate via Email.
9. On the following screen, click Export Activation Request.
10. Savethe ActivationRequest.txt file in your preferred location.
11. Attach this file to your email and send to activation@colligo.com.

You will receive a response from Colligo Technical Support with instructions for manual activation.

After Colligo Engage Outlook App is installed, a new group called Colligo Engage displays in the left-
hand pane in Microsoft Outlook:
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4 Favorites
Inbox
Sent Items

Deleted Iterns 814

4 Colligo Engage
Deleted Items
Browser

I+ Favarites

I Folders

I» Recovered Items

Search Folders

You can now add SharePoint sites and designate folder locations for your Favorites and Folders lists.

Checking for Updates

To check if you are using the most current version of Colligo Engage Outlook App, click the Colligo drop-
down arrow and select Check for Updates.

The www.colligo.com site launches in your web browser. If there is a newer version available, click the
Download the latest version now link to install the newer build.
Updating Your License Key

To change your license key:
1. Click the Colligo drop-down arrow and select Install License Key.

The Enter License Key dialog displays:

{? Enter License Key 22
Please enter your 25-digit license key (include dashes):
| Cancel
2. Enter your license key and click OK.
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CONNECTING TO COLLIGO ENGAGE CONSOLE

If your solution includes Colligo Engage Console, the prompt displays when you are connected:

= 2
@ Colligo Engage Console g

Please enter your Colligo Engage credentials:

User name: | | |

Password:

Forgot Password?

[ ok || concel

\ 7

Enter your User name and Password and click OK to connect.

If you have forgotten your password, click Forgot Password?

A password reset request has been submitted. A temporary password has been
zent to your registered email address,
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MANAGING SHAREPOINT SITES

Colligo Engage Outlook App lets you connect to SharePoint sites through Outlook. You can add, edit,

and remove sites, as well as add folders to your Favorites and Folders lists.

Adding a SharePoint Site in Colligo Engage Outlook App

You can add a SharePoint site to Colligo Engage Outlook App in one of two ways:

1. By using the SharePoint Sites dialog in Outlook.
2. By using the Connect to Outlook App button in Internet Explorer.

Colligo Engage

Using the SharePoint Sites Dialog in Outlook

When you add a site in Colligo Engage Outlook App, it is also added to Colligo Engage Windows App at
the same time.

In the Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.

The SharePoint Sites dialog displays:

r@- Colligo Engage Configuration l‘ézq1
SharePaint Sites | Lz SharePoint Sites
Favexite | EBadd [ Remove [BEar| 3 O
Folders

Add SharePoint Site
Search Locations
Search Options
Launchpad
Settings
Ciose |
2. Click the Add SharePoint Site link or the Add icon.
The Add SharePoint Site dialog displays:
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s e B
() Add SharePoint Site [

URL:

Examples: http://server/workspace
https:/fsecureserver/workspace

|Server Authentication

Authentication Type: |Auto-detect o

Auto-detect
@ Use default crq Windows Classic
Windows Claim-based

_ Usa the follow

Form-Based
User name: | ADFS 2.0
e Office365
3OS Office365 by Prompt
Domai CORPORATE
L oK ] | Cancel |

e

Lo

3. Enter the following information in the dialog:

a. URL: enter the web address of the SharePoint site you want to add. You can type or
copy-and-paste the address, or drag-and-drop an address from Internet Explorer into
the field.

b. Server Authentication

¢ Authentication Type: choose one of the following options

o Auto-detect

e Windows Classic

e Windows Claim-based

e Form-Based

e ADFS 2.0

o Office365

o Office365 by Prompt
¢ Use default credentials: select this option to choose default Windows credentials
« Use the following credentials: select this option to enter user-specific credentials

and enter the following information:

e Username

e Password

e Domain

4. Click OK. The site displays in the list. You can expand the site to see the subfolders:
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(? Colligo Engage Configuration S
SharePoint Sites = SharePoint Sites
Favarites = Add Remove Edit o
Folders L) Colligo Intranet
Earch L orabione L\ Firestarter Portal
) Marketing
Search Options L) Social
Launchpad
Settings
Close l

After adding your sites, you need to determine which libraries/folders are going to be upload-only or
offline locations. For more information, see Setting Folders as Upload-only or Offline.

Using the Connect to Outlook App Button in Internet Explorer

You can add a SharePoint site or library to Colligo Engage Outlook App directly from Internet Explorer
using the Connect to Outlook App button.

To add a site with the Connect to Outlook App button:

1. Navigate to the SharePoint site or library that you want to add to Colligo Engage Outlook App and
click the Connect to Outlook App button:

Internet Explorer 9:

Qf_ ==/'| .__:_. http://ws-sp2010/5itePages/Home.aspx
| aid| Colligo Intranet - Home x | [ﬁ
File Edit View Favorites Tools Help

% v B v [0 mn v Pagev Safety~v Tocls~ @~ &

Connect to Colligo Engage

sitesctions » B B BEeD

NOTE: If the Connect to Outlook App button is not visible, you need to enable the Command bar.

2. Ifyou are logged in with your default credentials, you are not prompted for a username and pass-
word.
If not, you are prompted for your login credentials with the Connect to Outlook screen:

3. Enter your login information and click Continue.
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The following screen displays.

Colligo Engage: Connect to Outlook

Connect this SharePoint location to Outlook:
http:/fvs-dev-sp2 010/5teveTest/Shared%
20Documents/Forms/Allltems.aspx

Add as Favorite in Engage

A Favorite is a lecation you frequently use to file email. ]
Selecting this option will add the SharePoint location ta 4 [ Favorites
Cutlook as shown here, Any sub-folders are not visible [ New Favarite
within Favorites.

-
4 Colligo Engage

"

[C] Add as Folder in Engage

A folder is used to represent a SharePoint document library

-
4 Colligo Engage

or folder. Selecting this option will add the SharePoint 4 [0 Favorites
lacation to Cutlook as shown here. All SharePoint sub- 4 7 Folders
folders within this library or folder will also be visible in 4 7] Mew Folder
Cutlook. £3 sub-folder
Y -
[ Continue | [ Cancel |

4. Check the Add as Favorite in Engage boxto add the location to your Favorites list.
If you are adding a site-level location, the option to add it as a Favorite does not display.
5. Check the Add as Folder in Engage box to add the location to your Folders list.

When the connection is complete, the site or library now displays in your SharePoint Sites list and,
depending on which boxes you checked, your Folders and/or Favorites list in Colligo Engage .

Enabling the Command Bar in IE 9

In Internet Explorer 9, the Command bar is disabled by default. To see the Connect to Outlook App
button, the Command bar must be enabled and visible.

To enable the Command bar:
1. Right-click in the white space at the top of your browser window:

al' | http://vs-sp2010/PM/SitePages/Home.aspu?RootFo O ~ & X l .| Product Management - Ho... SR

File Edit View Favorites Tools Help
Menu bar

Site Acti Browse Favorites bar

Command bar

v | Status bar

@ COI" O Collaboration Made Easy.” Product Management » Home

Colligo Intranet site for the Product Management de
| ¥ Lockthe toolbars

Home  AdminTest Document Workspace — Records Demo Show tabs on a separate row

Snagit

2. Select the Command bar option.

The Command bar displays at the top of your browser.
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Removing a Site

To remove a site from the Colligo Engage group:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, click the site you want to remove and click Remove.

A dialog asks for confirmation of the deletion.

NOTE: Removing a site removes all search locations, favorites, folders, and history items referencing
the site.
3. Click OK to continue with the removal, or Cancel to retain the site.
If you remove a site, any offline content that has not been synchronized is deleted. To recover any of this
content, please contact your administrator.

NOTE: Any sites that you remove from Colligo Engage Outlook App are also removed from Colligo Engage
Windows App.

Editing a Site
To edit a site in the Colligo Engage group:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe SharePoint Sites list, click the site you want to edit and click Edit.

The Edit SharePoint Site dialog displays.

3. Edit the fields as necessary. See Adding a SharePoint Site in Colligo Engage Outlook App for a

description of the fields.
4. Click OK.

NOTE: If you make edits to a site in Colligo Engage Outlook App the same edits are also applied to Colligo
Engage Windows App.

Refreshing a Site

To refresh a site in the Colligo Engage list:
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Click on the site you want to refresh and click the Refresh icon: .

NOTE: you can also refresh a folder by right-clicking on a folder under either your Folder list or
Favorites list in Outlook and selecting Refresh from the contextual menu
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MNew Folder...

*  Move Down
Rermowve this Favorite
Don't Prompt for Properties
Add as Folder

Rename...

Refresh
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CONFIGURING LOCATIONS FOR EMAIL FILING

After you have added your sites, you now need to determine which folder locations are upload-only or
offline. You can also set them as Folders and Favorites.

Setting Folders as Upload-only or Offline

You have the option to set your libraries/folders as either upload-only or offline. If you set a
library/folder as upload-only, the contents of those locations are only available to you when you are
connected to your SharePoint server. If you are not connected, the content is not available to you for
viewing or editing.

If you set a library/folder as offline, the folder structure and the content of the offline location is
downloaded to your machine for offline viewing and editing purposes. The contents of those locations
are downloaded to your local machine and you are able to access the content at any time, regardless of
whether you are connected to your SharePoint server or not.

If you do not set a library/folder as either an upload-only location or offline location, you will not be able
to file any emails, attachments, and other content from Colligo Engage Outlook App to SharePoint.

These settings are applied at the folder level; you cannot apply this setting to an entire site or sub-site.

NOTE: your administrator may have disabled the option to set a folder as offline. If this is the case, the
option is greyed out.

Setting a Location as Upload-only

Any location set as upload-only is marked with the following icon: Ce
All subfolders within an upload-only location are also set as upload-only.

Use one of the following three methods to set a folder location as upload-only:

1. Select asite to display any sub-sites or document libraries.
2. Double-click the library/folder you want to set as upload-only.

The folder structure of the location downloads.

OR

1. Select asite to display any sub-sites or document libraries.
2. Right-click the library/folder you want to set as upload-only and select the Set as upload-only
option from the menu.

The folder structure of the location downloads.

OR

1. Select asite to display any sub-sites or document libraries.
2. Select the library/folder you want to set as upload-only.

3. Click the Sync Settings icon and select Set as upload-only:
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= pas Ay
@ Calligo Engage Configuration ﬁ
SharePaint Sites = SharePoint Sites
Fevociie. | & Add Remove Edit e NP, |
foiters 4 ||| Firestarter Portal [Cf Setas upload-only
Search Locations L Marketing CE Setasoffline
ik Sales

Search Cptions E Finance

’:_-_‘1 Form Templates
Launchpad ’_—_j o
Settings E Manufacturing

E} Marketing

[E4 Sales

Setting a Location as Offline

After you set a library/folder location as upload-only, you can choose to make it an offline location if you
want the content in that location to be downloaded to your machine for offline editing and viewing
purposes.

NOTE: your administrator may have disabled the option to set a folder as offline. If this is the case, the
option is greyed out.

Any location set as offline is marked with the following icon: All subfolders within an offline location
are also set as offline.

Use one of the following two methods to set a folder location as offline:

1. Select asite to display any sub-sites or document libraries.
2. Right-click the library/folder you want to set as offline and select the Set as offline option from the
menu.

OR

1. Select asite to display any sub-sites or document libraries.
2. Select the library/folder you want to set as offline.

3. Click the Sync Settings icon =

s . . - )
f Colligo Engage Configuration ﬁ
SharePaint Sites = SharePoint Sites
Fawexites | BAdd 12 Remove (Edit | C 35 O J |
has 4[| Firestarter Portal | C¥ Setas upload-only
Search Locations L Marketing || [ Setas offline
il Salas -
Search Cptions E Finance
|___-j Form Templates
Launchpad '_:jl'l'
Settings E Manufacturing
|=__‘_1 Marketing
l'__.j Sales
B Cite Mt
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Making a SharePoint Location a Folder or Favorite

After you have set your folder locations as upload-only or offline (see Setting Folders as Upload-only or
Offline), you can then add your most frequently used SharePoint folder locations to either the Favorites
or Folders group in your Colligo Engage group in your Outlook Folder Tree. If you have not set a folder
location as either upload-only or offline, making it a Favorite or Folder automatically sets the location as
upload-only .

The purpose of setting a location as a Folder or Favorite is to provide a shortcut in your Outlook Folder
tree to that location. Then you can easily drag-and-drop emails, attachments, and other items into these
locations from within Outlook.

When you mark a SharePoint location as a Favorite, it is a link to that location only; if there are any
subfolders underneath that folder, you cannot navigate to them in the list. If you want to add a top-level
folder and its subfolder, you need to add them separately.

When you mark a SharePoint location as a Folder, you are adding the folder and any subfolders it
contains. If you want to move or copy an email to a folder in your Folders list, you can navigate through
the subfolders to the location where you want to file your email. This differs from locations in your
Favorites list, which do not include the folder hierarchy.

Adding a Location as a Favorite
You can add a SharePoint location to your Favorites list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, select the site and the folder within the site that you want to add to

your Favorites or Folders list and click the Add Favorite icon: D
3. Ifthelocation is not already set as upload-only or offline, it automatically synchronizes and
becomes an upload-only location.

The folder displays with the chosen icon beside it:
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SharePoint Sites.
Favarites

Folders

Search Locations
Search Options
Launchpad

Settings

= SharePoint Sites

o Add Remgve Edit s DD >, |

4 ||| Firestarter Portal 4
L) Marketing
L Sales
|___'"_1 Finance
’:_-_'1 Form Templates
B
|___=j Manufacturing
4 7 Marketing
E? Brochures
Eil Campaigns
E? Datasheets
Ei- Graphics
3 Market Research i
Ei- Proposals
0z Strategy
|___"'_1 Sales
’:_-_’1 Site Assets
’___j Social

|___=j Style Library

Close ]

Colligo Engage

NOTE: ifa syncis in progress, you can close the Configuration window without cancelling the sync.

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.

2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Favorites.

The Favorites dialog displays:
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s - J)
((’ Calligo Engage Configuration m
SharePaint Sites .. Favorites
Favorites % Add. ¢ Remove = Prompt |
Folders

Add Favorite

Search Locations
Search Options
Launchpad

Settings

Close l

3. Click the Add Favorite link or the Add icon
The Add Favorite dialog displays.

4. Browse to the location of the folder you want to add to your Favorites list, and click OK.

NOTE: if you right-click Favorites under the Colligo Engage list, you can select Add Favorite from the
contextual menu and the above dialog displays.

Any folders added display under Favorites in the Colligo Engage list:

4 Colligo Engage

Deleted Itermns

Browser

4 Favarites
Graphics (firestarter.sharepoint.co...

Marketing (firestarter.sharepoint.c...

Folders
Recovered Items

Search Folders

You can now use the folders to view, upload, and download your SharePoint files. Click on a folder to
view its contents:
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4 Favorites
Inbox
Sent ltemns
Deleted Items 835

4 Colligo Engage

Deleted Trems
Browser
4 Favorites Home
Graphics (firestarter.sharepoint.... m
Marketing (firestarter sharepaint.... ——

Folders

Manufacturing
Recovered lerns ]

Search Folders Marketing

Sales

Social
Campaign Tasks
Event Schedule
Staff Directery

Vacation Tracking

# EDITLINKS

M

v 0

ey

rketing » Graphics

r Portal Firestarter Marketing

=

Outloak

Flat  item Count

Name
Logos

firestarter
firestarter_blue
firestarter_blue_sm
firestarter_purp
firestarter_purp_sm
firestarter_sm
firestarter_sm_purp

Helen Jones_090ct13 10.11.45_logo
image

Calendar

Firestarter Sales

Tupload g2sync # edit

Find a file

People

P

Newsfeed

# EDITLINKS

Drag files here to upload

Modified

« September 19, 2013
. September 19, 2013
« March 05

- September 19, 2013
. September 19, 2013
« September 19, 2013
. September 19, 2013
« September 19, 2013

- October 09, 2013

Modified By
David Jackson
David Jackson
David Jackson
David Jackson
David Jackson
David Jackson
David Jackson
David Jackson

David Jackson

OneDrive  Sites
) SHARE Yy Fouow O

Search this site P

Author  Related Company  Person/Group  Product  Published

Excite;

NOTE: you can also add a folder to your Favorites list by right-clicking on a folder under the Folders
list and selecting Add as Favorite from the contextual menu:

Mew Folder...
[ Recover Deleted Itemns
2] SortSubfolders Ato Z

-

[

e

*  Move Down

Remuove this Folder

Add as Favorite

Rename...

Refrezh

Prompting for Properties

For locations that you have added as Favorites, you have the option to turn the prompt for the Edit

Properties dialog on or off:
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2 e
() Edit Properties [ESSEERT
Options
Content Type: | Email hd
Pro perties
Name Value e
= Name 010ctld 23.21.01_Djackson@firestarter.onmicre misg
Title Djackson@firestarter.cnmicrosoft.com
Subject Djackson@firestarter.cnmicrosoft.com
From Helen Jones E

From-Address

Sent 10/1/2014 fi5] | 1121 PM

Received [10/1/2014

To

To-Address

cC

CC-Address

BCC

BCC-Address ' ' -

[ ok ][ cancel |

This prompt is enabled by default. You can turn it on or off in one of two ways:
¢ Inthe Favorites tab, select the location you want to disable the property prompt for, and click the

Prompticon: E
OR
e Inthe Favorites group in the Outlook folder tree, right-click a location and select either Don't
Prompt for Properties or Prompt for Properties from the contextual menu:

Mew Folder...

*  Move Down

Remowve this Favorite

Don't Prompt for Properties
Add as Folder

Rename...

Refresh
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Removing a Location from the Favorites List
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Favorites.

The Favorites dialog displays.

3. Select the folder you want to remove and click Remove.

The folder is removed from your Favorites list and from the Colligo Engage section in your Outlook
Task Pane. However, the SharePoint location itself still remains marked as an upload-only location.

NOTE: you can also remove a Folder from your Favorites list by right-clicking the Folder in your
Favourites list in Qutlook and selecting Remove this Favorite from the contextual menu:

MNew Folder...

w  Move Down

Remove this Favorite

Don't Prompt for Properties
Add as Folder
Rename..

Refresh

Adding a Location as a Folder
You can add a folder to your Folders list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, select the site and the folder within the site that you want to add to

your Folders list and click the Add Folder icon: I:l
3. Ifthelocation is not already set as upload-only or offline, it automatically synchronizes and
becomes an upload-only location.

The folder displays with the folder icon beside it:
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SharePoint Sites
Favarites

Folders

Search Locations
Search Options

Launchpad

= SharePoint Sites

lo#Add | = Remove | A Edit | [ O 'j',,";'||-:| v

4 [} Firestarter Portal ,
L) Marketing
LU Sales
|=__'_1 Finance
I'__j Form Templates
By

Colligo Engage

|-__'_1 Manufacturing
4 [ Marketing 17 [

E? Erochures
Ei- Campaigns
E? Datashests
E? Graphics []
E? Market Research
E? Proposals
0z Strategy

E} Sales

I'___!, Site Assets

E‘_, Social

[ Style Library

Settings

Close l

NOTE: ifa syncis in progress, you can close the Configuration window without cancelling the sync.

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Folders.

The Folders dialog displays:

(C;“- Colligo Engage Configuration ﬂ
SharePoint Sites "] Folders
Favorites L Add e Remove |
Folders e
Add Folder
Search Locations
Search Options
Launchpad
Settings
Close 1
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3. Click the Add Folder link or the Add icon.
The Add Folder dialog displays:

@ had ol I e =

Selected location: Home

NOTE: if you right-click Folders under the Colligo Engage list in Outlook, you can select Add Folder
from the contextual menu and the above Add Folder dialog displays.

4. Browse to the folder you want to add to your Folders list and click OK.
Any folders added display under Folders in the Colligo Engage list:

4 Colligo Engage
Deleted Itermns
Browser

[ Favorites

4 Folders

I» Graphics (firestarter.sharepoint.co...

I Marketing (firestarter.sharepoint.c...

Recovered Items

Search Folders

NOTE: you can also add a Folder by right-clicking on a folder under your Favorites list and selecting
Add as Folder from the contextual menu:
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MNew Folder...

*  Move Down
Remowve this Favorite

Don't Prompt for Properties

Add as Folder

Rename...

Refresh

NOTE: as a best practice, it is recommended that you do not add folders with more than 50
subfolders to your Folders list, as they will take a long time to populate and refresh. If there is a top-
level folder that has a number of subfolders to which you frequently file emails, it is recommended
that you use the Move or Copy buttons and browse to the SharePoint location, rather than using
the Folders list in your Outlook pane.

Removing a Location from Folders List
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Folders.
3. Select the folder you want to remove and click Remove.
The folder is removed from your Folders list and from the Colligo Engage section in your Outlook
Task Pane. However, the SharePoint location itself still remains marked as an upload-only location.

NOTE: you can also remove a folder by right-clicking on a folder under the Folder list in Outlook and
selecting Remove this Folder from the contextual menu:

Mew Folder...

P
—

Sort Subfolders Ato £

*  Move Down

Remowve this Folder

Add as Favorite
Rename...

Refrezh
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Renaming a Favorite or Folder

When you have a location added as a Favorite or a Folder, you can right-click a location and select
Rename:

Mew Folder...

51 Sort Subfolders Ato £

w  Maove Down
Remuowve this Folder

Add as Favorite

Rename...

Refrezh

The Rename Favorite or Folder dialog displays:
(f." Rename Favaorite or Folder M

Pick a new name for this location:

@ Shared Documents (vs-sp2010)
Shared Documents {Colligo Intranet)
Shared Documents (hitp://vs-sp2010)
http:/fvs-sp2010/5hared Documents
Caolligo Intranet : Shared Documents

Shared Documents

[ ok ][ cancet |

The dialog offers you a number of options, as well as a blank field to enter your own custom name for the
location.

Choose an option and click OK.

If you have chosen one of the predefined options, the following dialog displays:
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r—Cn::nll'lgr::u Engage |"' bl ]1

I:GI Apply naming pattern to all unmodified lecations?

)R]

Choose Yes or No as preferred.

Viewing Upload-only Locations

Once your SharePoint locations have been set as either a Favorite or Folder, you can select the location
in the folder tree to display the content.

If you have set a location as upload-only, the content of the SharePoint location displays in the Outlook
interface as follows:

4 Favorites &= 2
| ' i
Inbox o e e S : & 2
e o 5 Outlook  Calend: ‘eople wsfeed L Sites. .. d T ?
Deleted Items 835 S o
BROWSE | FILES uﬁupv‘ € sHARE ¥ Fouow [
ADTEDI Firestarter Marketing Firestarter Sales # EDIT LINKS - 0
2 ESTARTE
Tg HOUNTAINRIRES é‘ . .
Aalige Bigson Marketing » Graphics
Deleted Items
Browser
4 Favorites iome
Graphics (firestarter.sharepoint... m T e o
Marketing (firestarter.sharepoint.c. o R —
Folders Drag f
Recovered ftems v [0 y o rou
Sl feEokiees Logos e September 19, 2013 David Jackson
Sy firestarter ..+ September 19,2013 [ David Jackson
Sy firestarter blue +es March 05 David Jackson Yes
= firestarter blue_sm +es September 19,2013 [ David Jackson
Sy firestarter purp «e September 19,2013 [ David Jackson
= firestarter_purp_sm +ee September 19,2013 [ David Jackson
= firestarter sm +we September 19,2013 [ David Jackson
# EDITLINKS
= firestarter_sm_purp «we September19,2013 [ David Jackson
{3 Helen Jones 090ct13 101145 Jogo =« October 09, 2013 David Jackson Excite;
image

NOTE: for upload-only locations, you cannot view any content when you are offline.

If a location is set as upload-only, the SharePoint content that displays looks exactly like the content
would in an Internet browser window. You can browse through the site and use typical SharePoint
functionality like opening a document in a program, checking an item in or out, renaming, or deleting an
item. Any changes you make to an item are reflected immediately in the SharePoint site so other users
can see them.

For more information, see Editing Content in Colligo Engage Outlook App

Viewing Offline Locations

Once your SharePoint locations have been set as either a Favorite or Folder, you can select the location
in the folder tree to display the content.
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If you have set a location as offline, the content of the SharePoint location displays in the Outlook
interface as follows:

o SE] = Marketing (firestarter.sharepoint.com) - Colligo Engage - Outlook 7 EH - O X
HOME SEMD / RECEIVE FOLDER VIEW COLUIGO LAUNCHPAD
El l._|"j I'~ - Search Move Unread/ Read Siirch People
- * - - “ @) Colligor S Rules - - fiz EE Address Boak
New  MNew - Delete | Reply Reply Forward =l - —|  Move Copy §
Email Items- &57 All Team Email . OneNote Follow Up Y Filter Email -
Mew Delete Respond Quick Steps ) Colligo Engage Maove Tags Find ~
< -
4 Favorites Flresmlr;er P?nal > Marketing
Inbox Marketing
Sent Items Mew - | Upload - | Filter = view:  All Documents -
Deleted Ttems 835 Name Modified Modified By Author  Related Company  Person/Group Product  Published
E‘ Brochures 915/2013 9:33 AM Mary White
E‘ Campaigns 9/19/2013 9:38 AM Mary White
b TMacKinnon@colligo.com [# patesheets 9/19/2013%:38 AM  Mary White
E‘ Graphics 9/19/2013 10:35 AM  David Jackson
4 Colligo Engage O Market Research  9/19/20139:37AM  Mary White
Deleted ems Et Proposals 9f19/2013 9:38 AM Mary White
. Nk
S C$ strategy 9/19/2013 ::37AM  Mary White
I» Favorites
4 Folders
[» Graphics (firestarter.sharepoint.co...
Marketing (firestarter.sharepoin...
Recovered ltems
Search Folders
Mail Calendar People Tasks -

If a location is set as offline, you can open, view, and edit the content as you would if the content was
online. The difference is that any changes you make are not reflected in the SharePoint site itself until
you are connected to the SharePoint server again, and you synchronize the site.

Viewing Content in Outlook View

You have the option of displaying your SharePoint content in Outlook view, which means your content
displays as if the items were emails. See Managing Settings for information about configuring your view

If you choose this option, your content displays as follows:
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B = L = Social (firestarter.sharepoint.com) - Colligo Engage - Outlook 7 @H - O X%
HOME SEND / RECEIVE FOLDER  VIEW COLLIGO LAUNCHPAD
= ".:| x E:'I ﬂi:,l t:" ? Mark as read |l—'§ Copy to: Advan. [ {ﬁ Psearch | ¥ - [7] =l |> Search People
s 7% Clean Up ~ € =4 “PM E3 To Manager - @) Colligo ~ =1 [EE Address Book
Mew  New Delete  Reply Reply Forward [ . Move Copy Move Rules Unread/ Categorize Fallow
Ermail ltems~ | & Junk- T EE More E1 Team Email v Done 2 o o . Read s Up- 7 Filter Email -
New Delete Respond Quick Steps ] Colligo Engage Move Tags Find ~
<
All Unread | search Sacial (firestarter.sharepoint.com) (Ctrl=E] Current Folder = o -
Glascntes & ! ! P e Ben Henderson (Demao) 060ct14 S
Inbox 1 D@ |FROM SUBJECT SIZE 4 - Last changed:  October 6, 2014
Sent ltems 4 Date: Today
Deleted ltems 1 |1 David Jackson SP¥am on Yammer_21Mar14 18.57.29_Top conversations for you this w... 2KE

David Jackson Spiceworks_24Mar14 17.02,05_Cloud-based file sharing - get your live ... 3 KB

Mon 2014-10-06 11:50 PM
+ BHendersanz@colligo.com 1 David Jackson Nick Sawadsky_16Jan07 23.57.49_RE Proposed protacal format.eml 2KB
s A\
4 Coliigo Engage ]  David Jackson Microsoft Canada_27Mar07 15.08.20_Your Microsoft Office 2007 syste... 3 KB Ben Henderson (Demo)
Document for approval
Deleted ltems |1 David Jackson Jerry McKenzie_185ep13 21.11.32_background material.eml 2KB
Browser [ | David JacksonIT Mews Daily_21Mar14 12,37.00_Remembering Pat McGovern, the tech.., 3 KB To Ben Hendersar (Deme)
Eoprs . Attachments B2 FinalPlan.xisx
| David Jackson Dave Mackay_23Aug13 15.49.23_ no subject .eml 2KB
4 Folders
Ermils (firestarter.sharepaint.com... ]  David Jackson Dave Mackay_224ug12 22.49.32_Latest Contoso Agreement.eml 2kB
4 Social (firestarter.sharepoint... [16] T David Jackson Colligo Sharepoint RETURN €01 -14.pdf 2KB Hi,
b Testing 4 David Jackson CAMP IT Conferences_10Mar14 12,09.23_Meet w Midwest Enterprise M... 3 KB -
b Recovered ltems Please see the attached final plan document for your
4 David Jackson Ben Henderson (Demo)_060ct14 23,49.34_Document for approval.msg 2 KB approval.
Search Folders
|1 David Jackson Argyle Executive Forum_27Mar07 19.00.00_Oprah CFO, Godiva, Eli Lilly... 3 KB Thank
anks.
4 David Jackson 3Bureaubonitoring_10Mar14 14.55.39_TransUnion Experian Equifax R... 22 KB
4 Date: Older
1 David Jackson Note Taking.pages.zip 102 KB -
Mail Calendar People Tasks -

ITEMS: 16

Note: After enabling you need to select a new folder within the Colligo PST to view the new mode.

When you select a folder, the list of contents within the location is displayed in the list pane. The
information displayed in the Outlook columns are:
e lcon: Theicon of the item
e From:The name of the person who uploaded the item (this may not be the same as the person
who last edited the file)
e Subject: The SharePoint File Name of the item
o Size: This is initially the size of the stub holding the metadata, but once clicked on it will display the
size of the item.
If you are using Outlook 2013 you can add the column Received to the view. This displasy the date and
time the item was uploaded to SharePoint. By default, although this isn't shown, Outlook sorts by this

column. The addition of the column is lost the next time Outlook restarts and Colligo Engage builds out
the view.

To edit items in this view right click the item and select Open. This opens the item directly from
SharePoint. Any edits to the items are saved directly or synced later to SharePoint. It may take some
time to update the preview of the item in Outlook after an edit has occurred on an item.

To reply or forward an email, right-click and select Open , then select the Reply or Forward button in the
ribbon of the email.

The Outlook search box will search the metadata of any items in the list view, and search the content of
any items that have been selected and have been previewed. From a more advanced search use the
Colligo Search pane by clicking on the Search button in the Colligo Engage ribbon.

Viewing Item Version History

If a library has versioning enabled, you can view an item's version history by choosing the Version
History option in the right-click contextual menu:
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MName
L FireStarter Pro Range datashee.., 3/5/2014 4:02PM

yE FireStarter Racer Rar E

Modified

Modified By Author  Related Company

David Jackson

Edit Properties. ..

Open with Adobe Reader

Copy
Paste

Check Out

Wersion History

Send As Link
Send As Attachment

Copy SharePoint URL

Copy SharePoint Doc ID URL

Rename

Delete

Create Shortout

Person/Group

4

Prod

Pro

id Jackson Jerry Mckenzie Extr

Colligo Engage

NOTE: this feature is enabled only when you are connected to your SharePoint server. If you are offline,
the option is greyed out.

The Version History window displays:

No
04
03
0z
01

Modified

2014-09-12 9:45
2014-09-10 6:02
2014-09-10 5:12
2014-08-13 5:29

Modified By
Rick Ramsay
Rick Ramsay
Rick Ramsay
Rick Ramsay

Size Comments
18 KB
18 KB
35 KB
35 KB

Click on a version number to open the SharePoint version of the item.
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EDITING CONTENT IN COLLIGO ENGAGE OUTLOOK APP

The actions available to you for editing content in Colligo Engage Outlook App depend on if the
SharePoint location has been set to upload-only or offline.
Editing Content in Upload-only Locations

The actions available for items that are in upload-only locations are displayed in the drop-down menu for
each item:

Inbox Library Tools
Sent tems Site Actions - @2 Browse [EBRIFIENH
Deleted ltems 835 j i g Check Out Version History J JSendTo .
L ‘j - 3 CheckIn £ Document Permissions | 4 2 Manage Copies
T Hew Upload  Hew Edit View Edit Emaila Alet Downloada Wi
olligo Engdge Document ~ Document» Folder Document i, Discard Check Out  Froperties Properties 3¢ Delete Document Link  Me~ Capy y Go To Source
Deleted Irems Mew Open & Check Out Manage Share & Track Copies
Browser sites [ Type  Name Modified
4 Favorites
Social
Marketing (Firestartersharepoint.c el Suppart L@  Briefings
Shared Documents (vs-sp2010) PEX (3  2014-08-08_122044_Ben Henderson (Demo)_item 1 |ajor26/2
Business Development
4 Folders @E, 6 1 release_160ct2013 View Properties
I Graphics (firestarter.sharepoint.co.. [} ACME Quote-Word 2003 E#  Edit Properties
Marketing (firestarter.sh: t. Libeaties heck
larketing (firestarter.sharepaint.c... - Check Out
Site Pages D e b
Recavered Ttems e B Desert Compliance Details
Search Folders g
Test B Lighthouse Alert Me
LH Send To >
=] Stepan Arakelyan_11Marié 14.59.20_RE Visio
Lists (3 Tessa Mackinnon_11Febi4 10,47.45_send and file K [icklses

Editing Content in Offline Locations

In offline locations, the actions available are more limited than upload-only locations. These actions are
displayed in the right-click menu for each item:

MName Maodified Madified By Author  Related Company  Person/Group  Prod
'@Firesbrher Pro Range datashee... 3/5/2014 4:02FM David Jackson Pro
=St 0 i A David Jackson 2 tHenzie E:

Edit Properties...

Open with Adobe Reader

Copy

Paste

@y Checkout

.Sj Wersion History

Send As Link

Send As Attachment

@ Copy SharePoint URL

@ Copy SharePoint Doc ID URL

Rename
¥ Delete

Create Shortout
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MOVING OR COPYING EMAILS

You can move or copy email to a SharePoint location in four ways:

1. Dragging-and-dropping emails.

2. Using the Move and Copy buttons in the Colligo Engage group.

3. Using contextual menu options.

4. Using Send-and-File.
If you choose to move an email, there is no longer a copy of it in your Outlook account. If you choose
to copy an email, a copy is retained in your Outlook account. This behavior is determined in your
settings dialog; see Managing Settings.

The experience of filing items to SharePoint in Colligo Engage Outlook App is the same regardless of
whether you are connected to your SharePoint server.

When you are connected to the network, any items are uploaded to SharePoint immediately, unless you
have modified the sync options. When you are offline, new or modified items are uploaded to
SharePoint according to your Sync Options settings. See Synchronizing Content in Colligo Engage
Outlook App.

NOTE: Uploading items to SharePoint will not block you from using other Outlook functions.

Dragging and Dropping Email

When you drag-and-drop an email to a SharePoint folder, the default behavior is to create a copy of the
email in that location while retaining the original in your Outlook account. You can change this behavior
in the Settings dialog. See Managing Settings.

If your default behavior is set to Move, you have the option of doing a right-click drag-and-drop that
displays the following dialog, giving you the option to Copy:

5] Deleted ltems

W Browser
Favarites
4 3 Folders
:'___gl Product Management [vs-sp2010.corporate.local)
4 EI Shared Documents (portal.colligo.com)

i'_:t Briefings

E‘ Phe Maye
CE spq . Is
53 Copy
[ Recove
L@ Search Cancel

NOTE: if you have a folder in your Folders list that has numerous subfolders that you have to scroll
through to find the folder to drag-and-drop your email into, it is easier to use the Move/Copy
buttons and use the filter feature to isolate the folder; see Using the Move and Copy Buttons.

To drag-and-drop an email to a SharePoint folder:

1. Select the email you want to move to a SharePoint location.
2. Click and drag the selected email to a folder in your Favorites or Folders list.

The Edit Properties dialog displays:
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5.
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g —
@ Edit Properties ESREERc)

Options

Content Type: | Email e

Properties

Name Value

+ Name 010ct14 23.21.01_Djackson@firestarter.onmicre msg

Title Djackscen@firestarter.onmicrosoft.com

Subject Djacksen@firestarter.onmicrosoft.com

From Helen Jones

From-Address

Sent 10/1/2014 1121 PM

Received | 10/1/2014

To

To-Address

cC

CC-Address

BCC

BCC-Address >

[ ok || cancel |

In the Options section, choose the Content Type from the drop-down menu.

In the Properties section, modify the fields as preferred.
The property fields are inherited from the SharePoint library you are moving your email into. Most
SharePoint 2010 metadata is supported, including Enterprise Managed Metadata (taxonomies,
keywords). Email properties such as To, From, and Subject are automatically extracted. The Title field
auto-populates with the Subject of the email.

Click OK to complete the process.

NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of
the email and in the list view:

|[Search Inbox (Ctri-E) # | 6 Tips to Get Started with Automated Testing [Complimentary eBook]
;Arrange By: Date [Conversatians) Mewest on top - Goran Begic <info@smartbearmail.com>
I - Sentt Thu 2/28/2013 5:13 AM
= MNCI¥'s 48 Hour Super Sale! Huge savings on the.., ] | 1o Archie Bunker
MCIX Newsletter 3/2/2013
-
To view this email 35 3 web page, click hers
4 Last Month [
i | 6Tipsto Get Started with Automated Testing [C.. B |
Garan Begic 2/28/2013 | y
|4 NCIX's Bundle Up the Savings Event - 54.99 Ship... B L | ‘W TestComplete =
MCIX Newsletter 2/28/2013 by SMARTBEAR
= [no subject] | |
Bernard Cheng 2/27/2013
-_,1 Get creative with your photos ] - - -
Windows 1013 Six Tips to Get Started with Automated
=4 Your eBook: Automated Testing in Virtual Labs ] &
SmartBear Software 2/26/2013 TEStI ng
| =) Automated Testing in Virtual Labs [Complimenta..,
_-Baran Begic e New SmartBear eBook! A T —
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To enable or disable this setting, see Managing Settings.

Using the Move and Copy Buttons

To move or copy an email to a SharePoint folder:

1. In Outlook, select the email you want to move or copy, or double-click it to display it in its own win-
dow. The Move and Copy buttons display in both views:
I; I;‘ + Search

' (@) Colliga~
Move Copy

Colligo Engage

2. From the drop-down menu, choose the folder you want to move your email to:

|_*: Lﬁ' 4 Search ;;
! ) Colligo -
Mowve Copy Mowve Rules On

Favorites

Marketing (firestarter.sharepoint.com)

P

Shared Documents (vs-sp2010)

. Other SharePoint Locations..,

3. Ifthefolder you want is not in your Favorites or History list, select Other SharePoint Locations.

The Select Move/Copy Destination dialog displays:

=
((’ Select Mowve Destination = | £

—
—

o Add Remove Edit

i} Colligo Intranet

Select a list or folder as a valid destination

| Cancel |

NOTE: When you are offline, locations that are not set to upload-only are greyed out. If you want to
be able to file items to specific locations when offline, ensure that you set them as upload-only prior
to going offline.

4. Browse to the location of the folder or list you want to copy the email to.
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NOTE: If you are filing to a location that has not been set as upload-only, you can set it by double
clicking it. You cannot do this when you are offline.

5. Click OK. The Edit Properties dialog displays.

6. Choose your Content Type and enter the Properties as needed.

7. Click OK to complete the process.
NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of the
email and in the list view:

jiocanch Inbox i) #|| 6 Tips to Get Started with Automated Testing [Complimentary eBook]
| Arrange By: Date [Conversations) Mewest on top - Goran Begic <info@5martbearmail.com>
Sent Thu 2/28/2013 5:13 AM
|-=J MNCI¥'s 43 Hour Super Sale! Huge savings on the... [ | Archie Buriker
NEIX Newsletter 3/2/2013
To view this email as 3 web pags, click hers =
4 Last Month i
] 6 Tips to Get Started with Automated Testing [C.. B |
Goran Begic 2/28/2013 | y .
|4 NCEX's Bundle Up the Savings Event - 54.99 Ship... B | ‘U‘ TEStCOmp|Ete =
NCIX Newsletter 2/28/2013 FSMARTBEAR
=4 [no subject] l
Bernard Cheng 24272013
| Get creative with your photos [ | - = =
Windows 2203 Six Tips to Get Started with Automated
=] Your eBook: Automated Testing in Virtual Labs ] H
SmartBear Software 2/26/2013 Tes'tlng
| =] Automated Testing in Virtual Labs [Complimenta..,
Goran Begic 2/26/2013 New SmartBear eBook! A e —
To enable or disable this setting, see Managing Settings.
Using Contextual Menu Options
To file emails to SharePoint using the contextual menu options:
1. Right-click an email and select Copy to SharePoint or Move to SharePoint from the contextual
menu:
2/22/2015 Copyright 2015 Colligo Networks, Inc. All rights reserved. Page 41 of 113

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage

IR 1
HOME SEND / RECEIVE FOLDER VIEW COLUGO LAUNCHPAD
R A~ ~ ¥
El ,._‘E T Ignare x & (E A t_a 2 Meeting Product Manag... 70 Manager [
8850 % Clean Up~ ﬁ(' € = E7 Teamn Email v Done
New  Mew Delete  Reply Reply Forward [ pjore - =] -
) are -
Ermail Ttems < e Junk~ Al I} < Reply & Delete ¥ Create New
Mew Delete Respaond Quick Steps [Fl
<
4 Favorites Search Current Mailbox (Ctrl+E) £ | Current Mailbox = €2 Reply B2
Inbox All Unread ByDate ~  Mewest 4
Sent Items 4 Today
Deleied emaiBas colligo.com on Yammer [ |
Your Yammer activity for Thursday, Octob... 7:49 AM

To Tessa Macki

colligo.com
“ Colligo Engage ' GWE removed
| Yesterd
Deleted Items —
Erowser < M)
4 Favorites . Microsoft Online Services Team =
Marketing (firestarter sharepoint.c... | : ion .Cnp‘.f. . ar. Tuedils PM
Lopy
Shared Documents (vs-sp2010
b= b & Quick Print
4 Folders
[ Graphics (firestarter.sharepaint.co... Micre £ Reply m
Marketing (firestarter.sharepaint.c... Viewy @- Reply All illl... 9/19/2014
Your b
Recovered Items £3 Forward [
Search Folders 4 Oider | -~ Mark as Unread
i i Micrg 1 Categorize » M =)
4 TMacKinnon@colligo.com REMEV, all..  B/20/2014
Your @ |* Follow Up 3
| Inbox .
Drafts [4] Siene B Eind Related 3 =3
RE: Inv Quick Steps » 8/6/2014
Sent frems Hella 1 P les
I Deleted ltems 835 ‘= Rules 3
I Colligo For SharePaint Bentas o v
R Re: Ma TA1/2014
Conversation History ot sul ¥y Copyto SharePoint » || Favorites 1
Ui Ben t B3 Move to SharePoint » Marketing (firestarter.sharepoint.corm)
Outbox
Re: Sp OneMot Shared Documents 2010
RSS Feeds candic nesete p20L0)
I Search Folders 5 = Ignore pn  Other SharePoint Locations... ke
erni =3 -
RE: 5p S 00k " ho.. 62172018 Hanoy Frid
Trytot X Delete . PRY

2. Choose a location from your Favorites or History, or choose Other SharePoint Locations to browse
to any location in any of your sites.

The Edit Properties dialog displays.
3. Choose your Content Type and enter the Properties as needed.
4. Click OK to complete the process.

NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of
the email and in the list view:

|[search Inbax (Ctrl - ) #| 6 Tips to Get Started with Automated Testing [Complimentary eBook]
ALENGE D DalE (e ot i) Newsstonten  * % Goran Begic <info@smartbearmail.com>

4 Earlier this Month I§ Copied to SharePoint

Sent: Thu 2/28/2013 5:13 AM

‘_-_.j MCI{'s 48 Hour Super Sale! Huge savings on the... [ | | 1 Archie Bunker
MNCIX Newsletter 3/2/2013
il
To view this email 35 3 web page, click hers
4 Last Month

|| 6 Tips to Get Started with Automated Testing [C.. B

Goran Begic 22802013 | y 2
|4 NCIX's Bundie Up the Savings Event - 5499 Ship... B | v' TeStCOmplete =
NCTX Newsletter 2/28/2013 by SMARTBEAR
= [no subject) [ |
Bernard Cheng 2/27/2013
-_.j Get creative with your photos [ | - - -
Windesws 272013 Six Tips to Get Started with Automated
l_g Your eBook: Automated Testing in Virtual Labs [ | H
SmartBear Software 2/26/2013 TEStI n g

= Automated Testing in Virtual Labs [Complimenta..,

Goran Begic 2/26/2013 NEW Smaﬁsear eBOOk! h
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Moving or Copying Multiple Emails

To move or copy multiple emails:
1. Select your emails in Outlook (use Ctrl + click to select more than one email).
NOTE: If you select greater than 10 emails, a warning displays and you have the option to cancel. If you
select more than 50 the operation cannot be completed. These numbers are configurable in the
configuration settings.
2. In Outlook 2010 or 2013, click either the Move or Copy button in the Colligo Engage group on the
Home tab; in Outlook 2007, click the Move to SharePoint or Copy to SharePoint button in the Col-

ligo Engage toolbar.
3. Select the folder location that you are moving or copying the emails to.

The Edit Properties dialog displays:

((=r Edit Properties = | El
| colligo.com on... ”
Options
4 Microsoft Onlin... § | i
Content Type: | Document
!Properties
Mame Value
= Name colligo.com cn Yammer_020ct14 07.!
Title
{LL] | L4
[ ok || cancel |
ey =,

4. Inthe left pane, select the email and edit the Content Type and Properties as needed.

See Using Managed Metadata for information about metadata fields.

See Applying Metadata to Multiple Emails for information about applying metadata to multiple
items.

5. When metadata for all emails is complete, click OK.

The emails are moved or copied to the selected folder.

Sending and Filing Emails
When you are sending an email, you can choose the send-and-file option so the email is saved to a
SharePoint site at the same time as being sent to the recipient.
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1. When your email is complete and ready to send, click the Send & File button that displays in the
Message ribbon of a new email message.

Alist of your SharePoint Favorites and your most recently used SharePoint folders (History) displays:

==l | B
MESSAGE INSERT OPTIONS FORMAT TEXT REVIEW

»

Send & Attach  Paste
File ~ - -

Favorites Basic Text
Marketing (firestarter.sharepoint.corm)

Shared Documents (v

£ Other SharePoint Locations...
Subject

2. Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.

The Edit Properties dialog displays.
3. Edit the Content Type and any Metadata fields as preferred.
See Using Managed Metadata for information about metadata fields.

4, Click OK to both send the email and file it to SharePoint.

NOTE: You can determine whether or not this action means that the email is copied or moved to the
SharePoint site by changing the Colligo Engage Outlook App settings. See Managing Settings.

Applying Metadata to Multiple Emails

You can apply the same metadata properties to multiple emails. However, the properties that are
available for group edit are the ones that are common to all selected upload items. Therefore, items that
are based on the same content type will have more common properties available for group edit than a
group of items that are based on different content types.

To apply the same metadata to multiple emails:

1. Select your emails in Outlook (use Ctrl + click to select more than one email).
2. In Outlook 2010, click either the Move or Copy button in the Colligo Engage group on the Home
tab; in Outlook 2007, click the Move to SharePoint or Copy to SharePoint button in the Colligo

Engage toolbar.
3. Select the folder location that you are moving or copying the emails to.

The Edit Properties dialog displays:
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(P ) Edit Properties

| colligo.com on Yam... || | ; I B
| Microsoft Oniine Ser... || IGRRS Edit: Enter property values to apply to the 2 selected upload items.

Options

Content Type: | Document

Properties

Mame Value

= Name

Title

I | »

| CK || Cancel |

e ~

4. Press the Ctrl key and click to select the emails in the left column that you want to apply the same
metadata to.

The metadata properties that are common to all selected items display. All metadata you enter is
applied to all selected emails:

NOTE: See Using Managed Metadata for information about metadata fields.

5. Edit the Content Type and Properties as needed.
6. When metadata for all emails is complete, click OK.

The emails are moved or copied to the selected folder.

Using Managed Metadata

Managed metadata is a set of hierarchical terms that you can use to classify items in SharePoint. The
terms are defined in the SharePoint site, and are available to you when you are filing emails.

To read more about managed metadata in SharePoint, please see:

http://technet.microsoft.com/en-us/library/ee424402.aspx

When you are entering metadata, you can use typeahead or select from the entire list of terms to make
the process more efficient, and you can add your own terms to a set of metadata.

Using Typeahead

If you are typing in a field that has managed metadata, a drop-down list of options displays when you
start typing the first few letters. You can then select from the list of options rather than typing in the rest
of the term.
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Cc-Address

Bcc-Address
Tags p| -

Suggestions

Public Relations [Keywords]

0K | [ Cancel

Selecting from a List of Metadata
1. To seethe entire list of metadata available for a given field, click the icon to display a list of avail-
able terms to choose from.
The Select term(s) dialog displays:

P
g| Select termi(s].

4 i PecetlD
I LanuageTest
7 Parks
7 Search using features
7 Swmp

[ ok || cancel |

2. You can double-click a term to add it to the list of selected terms, or you can select the term and
click Select.
The terms you selected are now added to the related field.
3. Click OK.

Using Person or Group Metadata
You can assign person or group metadata when filing emails.
Depending on how your SharePoint document library was configured, you may have the following

options to:

e enter multiple people and/or groups
e choose people only or people and groups
e choose from all users or a group

Validating a Person or Group Name

To validate a person or group name:
1. Ifyou only know part of the name of a person or group, you can enter one or more letters in the

field and click the validation icon E-"’.

The following error message displays:
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Person Single & &, [

No exact match was found. Ciick the item(x) thar did not resolve for more options.

2. Click the item to display a drop-down menu of suggestions based on the letter(s) you entered:

Person Single e 8. o
Suggestions le irem{s} thar did not resolve for more options.
Ben Henderson =

Person and Group Sit . 8, [ T
Eill England

Person Multi Brad Wilde 8, [

Person and Group M Braeden Calyniuk 8, W
Brent Bolleman

Person Home Membx CORPORATE\ablock & [

+ Person Required CORPORATEgbunker 5‘/ 8] | S

CORPORATE\ahoogensen

Group Within Group CORPORATE\barryj 8, L
CORPORATE \bbarker
None of the above | oK | | e ‘
Remaove

E More Names.. ﬁ

3. Select an item from the list to enter in the field, or enter new search letters.

Searching for a Person or Group Name

To search for a person or group name:

1. Click the address book icon to view the directory of your SharePoint people and groups. The
Search People dialog displays:

-
@‘- Search People ‘:'| =

Find A

Display Mame Email Account Name

Type into the search box above then press "Enter” to
start your search.

| Cancel

w s

2. Click the search icon to display a complete list of all people and groups, or enter a name in the
Find field and press Enter to search.
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3. Select the person or group you want to add to the field and click OK.
Filing Emails to a Drop-Off Library
You can drag-and-drop, send-and-file, move, or copy an email to a drop-off Library destination.

When you file an email to a drop-off library location, the following message displays in the Edit
Properties screen:

Content Organizer: Documents uploaded here are automatically mowved to the correct library
and folder after document properties are collected.
Options
Content Type: | Email -
Properties
Narme Walue 4|
= Name Bob Barker_030ct11 14.45.29_Terminal Services msg
Title Terminal Services i
To Bob Barl-:er|
Subject Terminal Services
From Dave Mackay
cC -
| OK | [ Cancel l

This message indicates that after the email is filed to the drop-off library, the related routing rules will
route the email to the appropriate location.

The upload dialog confirms that you have filed the email to the drop-off library:

Upload Progress M

Copying files to:
Dirop O Library (vs-dev-sp2010)

-1 David Jackson_060ct14 20.49.34_Document for app... &%

NOTE: If you file an email to a location that is a destination point of the drop-off library, Colligo Engage
Outlook App overrides the action and re-routes the email to the drop-off library itself, rather than the
destination. The reason for this is to ensure that the content is routed according to how the Content
Organizer has been configured to move content to the desired libraries.
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Managing Attachments in Emails
When you are sending an email, you have the option of inserting a link to a document location in
SharePoint, or inserting a SharePoint item as an attachment.
NOTE: this feature is currently available only when you are connected to your SharePoint server.
1. When you want to attach a document or insert a link, click the Attach button that displays in the
Message ribbon of a new email message.
Alist of your SharePoint Favorites and your most recently used SharePoint folders (History) displays:

E H =
IMESSAGE INSERT OPTIONS FORMAT TEXT REVIEW

5 Cut

Send & Attach  Paste

File = - - Format Painter

Colligo | Favaorites Basic Text
Marketing (firestarter.sharepoint.com)
E|j| Shared Documents (vs-sp2010)
send | bgy Other SharePoint Locations...
subjEct

2. Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.
The Insert Attachment From SharePoint dialog displays:

- B
f Insert Attachment From SharePoint = | =
|_Histt:|r).r Favarites | Folders | Sites | Vi |
i . Arrange By: Date | Newest on top
firestarter.sharepoint.com > Marketing
vs-sp2010 > Shared Documents
I Insert Item I F Insert Link | | Cancel |
Mt =y

3. You can find an item by accessing your History, Favorite, or Folder locations by clicking on the
appropriate tab, or see all of your SharePoint locations on the Sites tab. You can also use the Search

field to narrow the list.

NOTE: The number of items that display in the results pane when you select a folder location or
when you use the search feature, are set in the SharePoint Query Options field in the Search
Options tab (see Managing Search Options).
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4. Browse through either the search results or your folders and subfolders until you find the item you
are looking for. You can use the Arrange By toggle to arrange items by the Date the item was
created or by who created the item (From).

5. Choose one of the following options:

a. Insert Item: choose this option if you want to insert the item as an attachment
b. Insert Link: choose this option if you want to insert a link to the item's location in Share-

Point
6. Click Send or Send & File.

Copying an Outlook Folder to SharePoint
You can copy a folder from Outlook to a SharePoint location using Colligo Engage Outlook App.
NOTE: you can only copy folders to SharePoint; moving a folder is not available.

1. Right-click on the folder you want to copy to SharePoint and select Copy to SharePoint from the
contextual menu:

4 Inbox

E= Openin Mew Window
D Mew Folder...
i€ 1 Rename Folder
Copy Folder
Move Folder
q = Delete Folder
Recover Deleted Items...
b S MarkAll as Read
5 #=  Clean Up Folder

T3 Delete Al
T ) .
Show in Favorites
BT
W
Dri

Ser ¥ Move Down

[ Del Properties...

b Co Refresh
Cofr=: -
J_? Copy to SharePoint b || Favorites
Ju
o Mew Folder... Marketing (firestarter.sharepoint.com)
RSS Feeds Shared Documents (vs-sp2010)
I Search Folders f;n  Other SharePoint Locations...

2. Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.

The Edit Properties dialog displays:
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(@“- Edit Properties

—| colliga.com on Yam...

= Microsoft Onlinic Ser Group Edit: Enter property values to apply to the 2 selected upload items.

Options

Content Type: | Document

Properties

MNarme

« Name

Title

Colligo Engage

For information about applying metadata to multiple emails, see Applying Metadata to Multiple

Emails.

Using Outlook Rules to File Emails

To use an Outlook rule to file an email:

1. In Outlook, you can use the Rules Wizard to define the properties of the email that will be filed by

therule.

2. To choose the SharePoint folder you want to file the email in, click the move it to the specified

folder link in Step 2 of the Rules Wizard:
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Rules Wizard

Start from a template or from a blank rule
Step 1: Select a template

| Stay Organized

S Maove messages from sameaone to a folder

Q-_
%

Move messages with specific words in the subject to a folder
Move messages sent to a public group to a folder
|" Flag messages from someane for follow-up
¥ Move Microsoft InfoPath forms of a specific type to a folder
N Move RS5 items from a specific RSS Feed to a folder
Stay Up to Date
Display mail from someone in the New tem Alert Window
o) Play a sound when I get messages from someane

Start from a blank rule
Apply rule on messages [ receive
*= Apply rule on messages I send

Step 2: Edit the rule description {click an underlined valueg]
Lpply this rule after the message arrives

from people or public group
move it to the specfied folder
and stop processing mare rules

Example: Move mail from my manager to my High Importance folder

@ Send an alert to my mobile device when I get messages from someaone

Cancel gack | Mext> | [ Finish

The Rules and Alerts dialog displays:

-

Rules and Alerts

Choose a folder:

1H g

4 |[5 Colligo Engage | K
= Deleted tems
) Browser Cancel
L Favorites
Falders

Recovered ltems
p B2 TMackinnon@colligo.com
= Public Folders - TMacKinnon@colligo.co

4 [0 | »

3. Browse to your preferred SharePoint folder in the Colligo Engage group.

4. Click OK.

5. Edit the remaining elements of the rule description in the wizard and click Finish.

Colligo Engage

All emails that meet the criteria of the rule are filed to the SharePoint location you selected; however,

the Edit Properties dialog displays so you can edit the metadata for each email.

Using Outlook Quick Steps to File Emails

To use Quick Steps to file emails:
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1. Inthe Quick Steps group on the Home ribbon, click Create New:

Preduct Manag... 3 To Manager
ET Team Email v Done
(2 Reply & Delete -
Quick Steps ]

The Edit Quick Step dialog displays:

| Mo

Add actions below that will be performed when this quick step is dicked on.

Aclions

Choose an Action

Add Action

Shortcutkey: | Choose a shortcut E:[

Tooltip text:  This text will show up when the mouse hovers over the guid step,

2. In the Name field, enter a name for the Quick Step.
3. Under the Choose an Action drop-down menu, in the Filing group, choose Move to folder or Copy
to folder as preferred.

After you have chosen the Filing action, the Choose folder menu displays on the Edit Quick Step
dialog.

4. Choose Other Folder from the drop-down menu.
The Select Folder dialog displays:
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Select Folder |

Folders:

4 |[E Colligo Engage | ok |

=] Deleted Items

=
&} Browser | Cancel
[» "4 Favorites —_—
Folders Mew...

Recovered ltems

L o

5. Choose a folder from the Colligo Engage group and click OK.
6. Click Finish.

You can file emails to the SharePoint location you chose by selecting an email in Outlook and clicking
the Quick Step you created in the Quick Steps group.

The Edit Properties dialog displays so you can edit the metadata for each email.
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MANAGING SETTINGS

To manage your settings:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Settings.

The Settings dialog displays:

© Calliga Engage Configuration L&J
SharePoint Sites - Setti ngs
Favorites History
Folders : .
Mumber of History items: 10

Search Locations

Search Options

Drag-and-Drop Behavior | ESend—an d-File Behavior
Launchpad ©® Copy to SharePoint @ Copy to SharePoint
Séiﬁn‘gs 1 Move to SharePoint ' Move to SharePoint

|
]

@ Enabled  Label: Copied to SharePoint
) Disabled

View SharePoint content in:

) Qutlook View

@ Browser and Offline View

Logging

Log level: [Marmal v

Log file: Cpen log file location

Close |

e ¥

3. Inthe History section, enter the maximum number of items you want to display in the History list
(number must be between five and 50).
4. In the Drag-and-Drop Behavior and the Send-and-File Behavior sections, choose one of the fol-
lowing options:
e Copy to SharePoint: choose this option if you want to retain a copy of the email in Outlook
as well as filing a copy in SharePoint
e Move to SharePoint: choose this option if you want to move the email to SharePoint with-
out retaining a copy in Outlook

NOTE: If you choose the Move to SharePoint option as the default behavior, you have the
option to right-click and drag one or more items into a destination folder, and a contextual
menu displays, giving you the option to Copy OR Move the item.
5. Inthe Mark Copied Emails with Label and Color section, choose from the following options:
o Enabled: if this setting is enabled, the text in the Label field displays in the header of any
email that has been copied to SharePoint
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o Disabled: if this setting is disabled, there is no indication in the header of an email header
that has been copied to SharePoint
e Label: The default text in the label field is Copied to SharePoint; enter a new label if pre-
ferred
e Color: Choose an Outlook color category from the drop-down menu for the label to display
in
NOTE: this label is automatically applied to any items filed when offline.

6. Inthe View SharePoint content in section, choose from the following options:

e Outlook View: Choose this option if you want to display the content of the Share-
Point location as an Outlook folder view with a preview pane (see Viewing Upload-
only Locations)

e Browser and Offline View: Choose this option if you want to display the content of
the SharePoint location as either upload-only or offline (see Viewing Upload-only
Locations)

7. The Logging section allows you to set the level of detail you want to have in your error log files.
These log files assist Colligo technical staff in solving any issues that may arise while using Colligo
Engage Outlook App.In the Logging section, select the preferred option from the Log level drop-
down menu:

o Off: select this option if you don’t want to log any information about any activity errors or
warnings
o Normal: select this option to log information about activity, errors, and warnings
NOTE: this is the default logging level

o Verbose: select this option to include more detail about activity, errors, and warnings
o Verbose with Web Services: select this option to include the most detailed level of infor-
mation about activity, errors, and warnings

NOTE: choosing this option creates a very large log file and may slow the performance of
your system

8. The Logging section allows you to set the level of detail you want to have in your error log files.
These log files assist Colligo technical staff in solving any issues that may arise while using Colligo
Engage Outlook App. Click Open log file location to access the log files.
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CONFIGURING LAUNCHPAD

NOTE: The Launchpad feature only functions when you are connected to your network.

Launchpad is a ribbon in Outlook where you can create groups that contain buttons linking to your most
frequently used web pages and web applications for quick access from within Outlook. Once you have
buttons you can choose to add related items underneath it, as shown in the below image:

Faolder View Colligo Colligo Launchpad B

©] “

[ Uspept | CRM | Sharepoint
of Justice = Favorites =

——

i® Legal resources epaint sites

Legal forms

[termn Group Buttor

Launchpad

NOTE: Launchpad is not available in Outlook 2007.

To configure the Launchpad ribbon:

1. Inthe Colligo Engage group on the Home tab, click the Colligo drop-down arrow and select Con-
figure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Launchpad.

OR

From the Launchpad ribbon, click the Launchpad icon to display the configuration dialog:

B & M Marketing (firestarter.sharepoin
HOME SEND f RECEIVE FOLDER VIEW COLLIGO LAUNCHPAD

©

Launchpad Favorites

-

Colligo

The Launchpad dialog displays:
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- e i
Cf_“- Colligo Engage Configuration m
Shar=Paint Sites [ Launchpad
Favorites o Add = Remove [ Edit|3.5 Display Favorites ;ﬂélmport _éﬁ Export |
Folders =
4 LAUNCHPAD
Search Locations 7.7 Engage Favorites

Search Cptions
Launchpa

Settings

Close l

Editing the Launchpad Tab

To edit the name of the Launchpad tab:
1. Select Launchpad and click Edit.
The Edit Launchpad dialog displays:

s Ay
© Edit Launchpad -
: p

Title: LAUNCHPAD

Screen Tip:

Description:

| ok || cancel

L "

2. Edit the Title field.

3. Enter Screen Tip text and a Description if needed.

4. Click OK.

5. Restart Outlook for the change to take effect.
Adding a Group
To create a group in Launchpad:

1. Select Launchpad and click Add.

The Add Group dialog displays:
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Title: Mew Group

Sereen Tip:

Description:

[ CK Jl Cancel |

o o

In the Title field, enter the name of the group.
Enter Screen Tip text and a Description if needed.
Click OK.

5. Restart Outlook for the change to take effect.

Eall SN

Adding a Button to a Group

Once you have added a group, you can add a button to it:
1. Select the group that you want to add the button to and click Add.
The Add Button dialog displays:

) Add Button e S|

Title: Pew Button

URL:

Icam:
!Erowse
Screen Tip:

Description:

L CK ] | Cancel |

L "

2. IntheTitle field, enter the name of the button.

Colligo Engage

3. Inthe URLfield, enter the address of the web page or web application. After you enter the URL and
click away from the field, the icon associated with the URL displays in the Icon space. If you want to
change theicon, click Browse to choose your preferred icon. If you click Clear, the default icon

above is used.
4. Enter Screen Tip text and a Description if needed.
5. Click OK.
6. Restart Outlook for the change to take effect.
Adding an Item to a Button
Once you have added a button, you can add one or more items to it:
1. Select the button that you want to add the item to and click Add.
The Add Item dialog displays:
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(@ Add item )

Title: MNew [tem

URL:

Icon;

|Browse|

Screen Tip:

Description:

[ oK ]l Cancel |

' "

2. IntheTitle field, enter the name of the item.

3. Inthe URLfield, enter the address of the web page or web application.After you enter the URL and
click away from the field, the icon associated with the URL displays in the Icon space. If you want to
change theicon, click Browse to choose your preferred icon. If you click Clear, the default icon
above s used.

NOTE: this is a required field. You cannot create an item without a URL.

1. Enter Screen Tip text and a Description if needed.
2. Click OK.
3. Restart Outlook for the change to take effect.

Displaying Colligo Engage Outlook App Favorites

If you have added SharePoint locations to your Colligo Engage Favorites list, you can also choose to
display them in the Launchpad ribbon.

1. Click the Display Favorites button in the Launchpad dialog:

>
(T Colliga Engage Configuration

SharePoint Sites n Launchpad

. r i
ROt I = Add & Remove AEditI . Display Favorites_l 5
Folders

4 [ AUNCHPAD
Search Locations 1 Engage Favorites
Search Cptions @ EEW FPEAD
[4] New Buttan

Launchpad
Settings

2. Restart Outlook for the change to take effect.
NOTE: This button is a toggle. To remove the Favorites group from the Launchpad ribbon, click the
button again and restart Outlook.

The SharePoint locations from your Favorites list do not display in the Launchpad dialog; they
display in the Launchpad ribbon in a group called Favorites:
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=

HOME SEMD / RECEIVE FOLDER VIEW COLLIGO

© P

Launchpad Fawvorites

-

Collit ¢  Marketing (firestartersharepoint.com)

4 Favorite ¢ Shared Documents (ws-sp2010) -Hallba; [Ctri+E)

Viewing Launchpad URLs

After you have configured your groups, buttons, and items, they display on the Launchpad tab in
Outlook:

¥

HOME SEMD / RECEIVE FOLDER VIEW COLLIGO LAUNCHPAD

© * © O

Launchpad Favorites  Mews Entertainment

Colligo Mews Ent

Click on any button or item to display its associated URL. If you move to another tab in Outlook, you
can click the Browser icon in the folder tree to go back to the last page you viewed.

You can use the refresh icon and the browser buttons in the navigation bar to navigate through the
web page.

TEERE

HOME SEND / RECEIVE FOLDER VIEW COLLIGO LAUNCHPAD

Launchpad Favorites Mews Entertainment

Colligo Mews Ent -
4 Favorites

nbat EDITION: INTERNATIONAL | us. | m
Sent tems :

Deleted Items 835

Video World WU.S. Africa Asia Furope Lafin America Middle East Business World Sport Entertainment Tech

4 Colligo Engage

Deleted Items

Browser | Dvinber 3, 2014 — Updatad D121 GMT (0021 HKT Ma

[Sulygel -l (0][ef W Scenes from the fieid - Hong Kong - Eboia - ISIS - Pluto a planet? - Supercars - Kelly Slater - 35,000 walruses

4 Favorites
Marketing (firestarter,sharepoint.c..,
Shared Documents (vs-sp2010)

2

I Folders BREAKING NEWS

i

STORFPUSETTY IMAGES

FOLLOW US
m :@l W Follow @c

I Recovered Items

Search Folders

-

Importing and Exporting Launchpad Settings

You can export your Launchpad settings and save it as a .ribbon file on your computer. You can then
import this file to another installation of Colligo Engage Outlook App.

NOTE: The Colligo Engage Favorites list is not exported.
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To export a Launchpad configuration file:

1. Inthe Launchpad configuration dialog, click the Export button.

=
@“- Colligo Engage Configuration

SharePoint Sites
Fawvarites
Folders

Search Locations
|| Search Options

Settings

K Launchpad

1p Add | s Remove [ Edit| 5.0 Display Favorites !ﬂi;lmportl Lé&i Export |

4 |AUNCHPAD
1.7 Engage Favorites
- @ Mews & Ent
A |:| Mews
=l enn
F] EI Entertainment
@ Yahoo

A Windows Save As dialog displays.

2. Enter a name for the file and browse to the location where you want to save it.

3. Click Save.

To import a Launchpad configuration file:

1. Inthe Launchpad configuration dialog, click the Import button.

7
@_“- Calliga Engage Configuration

SharePoint Sites
Favorites
Folders

Search Locations
|| Search Options

Settings

& Launchpad

| 19 Add Lis Remove [L# Edit| i Display Favorites l;ﬂl;Import _45# Export

4 | AUNCHPAD
5.7 Engage Favorites
rl @ Mews & Ent
4 EI MNews
[=] cnn
4 EI Entertainment

A Windows Open dialog displays.

2. Browse to the location of the saved .ribbon file.
3. Click Open. The Launchpad groups, buttons, and items display in the dialog.
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SEARCHING SHAREPOINT AND OUTLOOK

NOTE: This feature requires a network connection.

Colligo Engage Outlook App provides advanced search functionality, allowing you to search within
specific SharePoint sites and your Outlook account. You can use this to search for email or documents
that you or others have uploaded to SharePoint, or for items in your Outlook mailbox.

NOTE: When you upload an item to SharePoint, it is available immediately within the SharePoint site.
However, the item will not be returned in a search until the item has been indexed by a SharePoint
crawler. The timing and frequency of the crawls are set by your administrator.

Enabling Search Capability
To enable search functionality in Outlook 2010, click the Search button in the Colligo Engage group on

the Home tab; in Outlook 2007, click the Show/Hide Search Pane button in the Colligo Engage toolbar:

E |J;“ 4 Search

€ Colligo -
Move Copy

Colligo Engage

A search pane displays along the right side of your Outlook main window. You can move the search
pane to any location in your Outlook window and it stays in that location the next time you start
Outlook.

Colligo M
| sl

Enter crifena fo seanch ShareFoint.

Searching

You can perform both basic and advanced searches using Colligo Engage Outlook App’s search function.

A basic search means you type a keyword and the search returns anything that matches that word,
regardless of the occurrence of that word.

An advanced search means you are searching specific metadata fields, using the same syntax you would
use in an Outlook search. You type the name of the metadata field you want to search, followed by a
colon, followed by the term you are searching for. You can enter multiple search terms in this format.

For example, a search with the parameters to:John subject:manual means you are searching the
metadata fields to and subject for the terms John and manual. Any results returned from the search will
meet both of these search criteria. The searchable metadata fields are configured by your systems
administrator. Custom metadata is also supported.
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After you have entered a search term and started the search, you can look at the progress of the search
by clicking the arrow at the bottom of the search pane:

‘| m | "

. ltems: 8 Locations: 2 in progress, 1
completed

The search locations display. You can click Cancel to remove results from a particular site from the
search.

cofligo

Arrange By: Date Mewest on top

4 5f372012
il Demol

¢ [ b

4 |tems: & Locations: 3 in progress. 1

completed
3 Celligo Team Site (Colligo ™
Fetrigving search mets |Cancel|
data. (0 item(=) found)

JBDemo (JEDema)

/ bl P Ty
Performing search.... (0 | Cancsl|
itemn{s) found)

) Briefcass (Bnefcase)

Search complete (B itemdz) found)

] Calligo Team Site (Colligo”

Performing search__. {0 Cancal|

item{s] found)

Defining Search Locations and Terms

To define your search locations and parameters:

1. Enteryour search term in the search field.
2. Click the drop-down arrow to manage your search locations and options:

Search Locations
Search Options

3. Select Search Locations to select the location(s) you want to search in. For more information, see
Managing Search Locations.

4. Select Search Options to define your search options. For more information, see Managing Search
Options.

5. Click the search icon to begin the search.
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Any results display under the search field:
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Colligo * X
| test D ow
Arrange By: Date Newest on top
4 28/06/2011
(W]} Corporate'Bcheng 117 PM —
Mew Microsoft Office Word Document.doox
| Corporate\Echeng 757 PM
Bernard Cheng_28Jlunll 08.44.01_testmsg
| Corporate\Echeng 346 PM
Bernard Cheng_28Jlunll 08.44.01_testmsg
Corporate\Bcheng 339 PM
andom_test_doctd
()] Corporate\Bcheng 339PM +
[+ ltems: 202 Locations: 1 completed. 1 complete with warning

NOTE: If you are not getting any search results it is likely because the search capability for the

SharePoint site has not been configured. Please contact your systems administrator.

Viewing Search Results

You can arrange your search results by item Date or Author (From). To toggle between these views, click

on the Arrange By field in the results pane and select Date or From:

S

v Date

From

e

You can also sort the results by viewing the newest item on top or the oldest item on top. To toggle
between these views, click the top-right corner of the search results to get the view you want:

|te51 2 -

Arrange By: Date

Oldest on top

4 01704/2007

{ul Corporate\Barry]

B's Beverages, Inc. F

4 09/03/2010

(@]} Corporate\Ahoogensen
|

act Document.d

[alm}

Wl Corporat

e\Ahoogensen

entZ.docx

]| Corporate\Ahoogensen

est Document3.doox

(@] Corporate\Ahoogensen

Test?2.dock

I+ |tems: 202 Locations: 1 completed; 1 complete with warning

12:50 AM

12:52 AM

12:54 A

12:38 AM

Additionally,if an email with an attachment is returned in your search results, the paperclip icon displays

to indicate the attachment:
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Caolligo - X

| invoice] Al

if-‘-.rr:mge By: Date | Mewest on top

4 Today
] Dave MackKay [ 9:51 AM

[ % VRN WU g, Sl S
{Hachment for Inve

~ L= AT LT A

Managing Search Results

You can open and view items that display in your search results, as well as create a new email with a link
to the SharePoint item.

Use the x icon to clear the search term and search results:

Collige - X

colligo | b 4 |C||

Viewing an Iltem
To view an item in your search results, either double-click it to open and view, or right-click and select
Open from the contextual menu:

4 Colligo Technical Support
] Colligo Technical Support

[FT—

FW: Blg |

Open

Send As Link

4 Corporall Send As Attachment
.| Cerporst  Copy SharePaint Link .

Emailing a Link to an Item
To email a link to an item in your search results, right-click the item and select Send As Link from the
contextual menu. This opens up a new email with a link to the item's location in SharePoint.

You can also drag-and-drop the item into your Inbox for the same result.

If you have an item in your search results that is an email with an attachment, you can open the email,
then drag-and-drop the attachment into your inbox; this opens up a new email with the attachment
attached. The subject line of the email defaults to the name of the attached file.

Sending Item as an Attachment

To send the item as an attachment, right-click the item and select Send As Attachment from the
contextual menu. This launches a new email with the search result item in the Attached field.
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Creating a Link to an Item

To copy the link to the item’s location in SharePoint, right-click the item and select Copy SharePoint Link
from the contextual menu. You can then paste the link into an email or document as needed.

Managing Search Locations

Any SharePoint site that you add to Colligo Engage Outlook App is added to your search locations list by
default. You can remove a site from the list to reduce the scope of a search, but then add it back at a later
time for another search.

Adding a Search Location
You can add a site to your search locations list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthesite list, click the site you want to add to your search locations and click the Add Search Loca-

tion icon: .

A small magnifying glass icon appears at the end of the site name, indicating it is included in your
search locations list.

Colligo Intranet
4 Firestarter Portal
Marketing
Sales

E}Finance

E_j Form Templates
&

E_j Manufacturing

m Marketing 7.7 [ »

E_j Sales

E_j Site Assets

E_j Social

E_j Style Library

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Search Locations.

The Search Locations dialog displays:
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@ Colligo Engage Configuration [

SharePoint Sites +~ Search Locations

fedites JoAdd ¢ Remove

Folders
Add Search Location

Search Locations
Search Options
Launchpad

Settings

Close |

3. Click the Add Search Location link or the Add icon.
The Add Search Location dialog displays:

() Add Search Location SR

~

L.} Colligo Intranet
L} Firestarter Portal

Please select a location to search from

| Cancel |

e =)

4. Select the site you want to add to the search list and click OK.

The site is now included in your search locations list.

Removing a Search Location
To remove a site from your search locations list:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.

2. Intheleft-hand pane of the Colligo Engage Configuration dialog, select Search Locations.

3. Inthesite list, click the site you want to remove and click Remove. The site no longer displays in the
list.
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Managing Search Options
The Search Options area of Colligo Engage Outlook App lets you define your search parameters. To
define the search options:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Search Options.

The Search Options dialog displays.

g w
[ Colligo Engage Configuration LJ-EZ-
SharePaint Sites P Search Options
Favarites | (-}utlzmk
Folders [£] Search all mail items
Search Locations [Z] Search Outlook Inbox
Search Optians Limit results to: - 200
Launchpad SharePoint Query Options

Settings Limit results to: 200

iSearch On

{2} Files and Folders @ Files Only © Folders Only

@ All Files ) Filter Files

gEEe e

Close |
J

3. Inthe Outlook section of the dialog,choose your parameters:
a. Check the Search all mail items box if you want to search your Inbox as well as all other fold-
ers in your default mailbox. The following folders are not included in the search: Junk E-Mail,
Deleted Items, Public Folders, and RSS Feeds. If you have more than one email address
linked to Outlook, Colligo Engage Outlook App searches only the default account.
b. Check the Search Outlook Inbox box if you want to limit the search to your inbox content.
c. Inthe Limit results to field, enter the number of results you want returned per folder.
4. Inthe SharePoint Query Options section, enter the results number in the Limit Results to field.
5. Inthe Search On section, choose your parameters:

a. Choose from one of the following:
a. Files and Folders
b. Files Only
c. Folders Only
b. Ifyou choose either the Files and Folders or Files Only option, you can further
determine the file types you want to search by choosing one of the following:
a. All Files
b. Filter Files
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c. Ifyou choose Filter Files you can further define the type of files you are searching by
checking the boxes of the file types in the list.

Custom Search Folders

Custom search folders are functionality native to Outlook and are separate from Colligo’s search
capability. A custom search only searches within Outlook, whereas a Colligo Engage Outlook App search
includes both your Outlook account as well as your SharePoint sites.

2/22/2015 Copyright 2015 Colligo Networks, Inc. All rights reserved. Page 70 of 113

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage

CoLLIGO ENGAGE WINDOWS APP

Welcome to Colligo Engage Windows App, which offers full offline support, advanced metadata support,
and industry-leading sync and security capabilities, enabling organizations to embrace BYOD while
maintaining control of their corporate data.

Key Features

e Tag: Add automatic or customized metadata
¢ Sync: Make your SharePoint content available when offline
¢ Share: Replace attachments with links for easy collaboration

Benefits
e SyncSharePoint desktops & laptops for mobility & performance
e Enable productive offline access
o Edit files, lists, and metadata
o Easy-to-use, familiar desktop interface
e Drive enthusiastic SharePoint adoption
¢ Alleviate slow connectivity to SharePoint
¢ Replace network shares with SharePoint for document storage and collaboration

Platforms Supported

¢ SharePoint 2010, SharePoint Online (Office 365), and SharePoint 2013
¢ Outlook 2007, 2010, and 2013 (32-bit and 64-bit)
¢ Windows Vista, Windows 7, and Windows 8

NOTE: The screenshots in this document use Outlook 2010, SharePoint 2010, and Windows 7. Your user
interface may differ depending on your specific configuration.
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INSTALLING AND ACTIVATING COLLIGO ENGAGE WINDOWS APP

NOTE: If you have already activated from the Colligo Engage Outlook App interface, you do not need to
activate Colligo Engage Windows App. See Installing and Activating Colligo Engage Outlook App.

To install and activate Colligo Engage Windows App:
1. Double-click to open the Colligo Engage Windows App XX.zip file and extract the contents.
2. Inthefolder, double-click the folder that corresponds with your operating system:
a. x86: choose this option if you have a 32-bit operating system
b. x64: choose this option if you have a 64-bit operating system
Double-click Setup.exe .
Follow the steps in the install wizard.
After installation is complete, enter your information to activate the software.
If you are unable to connect to the activation server, an error message displays:

€ Colligo Engage [ﬁj

Nowu s

To complete your installation, please complete the fields below and click
Activate. Your privacy is important to us, and your personal information will
never be shared with third parties.

MNarme: David Jackson
Organization: Firestarter
Email address: djackson@firesiarter.con‘l

&3 Unable to connect to the activation server. Please try again later
or activate by email.

| Activate || Activate by Email || Bt |

NOTE: The inability to connect could be due to firewall settings in your corporate network or a
dropped internet connection. If the connection issue is temporary, Colligo advises to attempt
activating at a later time before trying activation by email.

8. Click Activate by Email.
9. On the following screen, click Export Activation Request.
10. Savethe ActivationRequest.txt file in your preferred location.
11. Attach this file to your email and send to activation@colligo.com.
NOTE: If you are upgrading from a previous version of this product, you may see a migration wizard that
helps you migrate your settings into this new version.

Checking for Updates
To check if you are using the most current version of Colligo Engage Windows App, select the Help menu
and select Check for Updates.

The www.colligo.com site launches in your web browser. If there is a newer version available, click the
Download the latest version now link to install the newer build.

Updating Your License Key

To change your license key:
1. From the Help menu, select Install License Key.
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The Enter License Key dialog displays:

2. Enter your license key and click OK.
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CONNECTING TO COLLIGO ENGAGE CONSOLE

If your solution includes Colligo Engage Console, the prompt displays when you are connected:

= 2
@ Colligo Engage Console g

Please enter your Colligo Engage credentials:

User name: | | |

Password:

Forgot Password?

[ ok || concel

\ 7

Enter your User name and Password and click OK to connect.

If you have forgotten your password, click Forgot Password?

A password reset request has been submitted. A temporary password has been
zent to your registered email address,
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ADDING SHAREPOINT SITES

Colligo Engage Windows App lets you connect to SharePoint sites through both the stand-alone interface

and the Windows Explorer extension.You can add a SharePoint list or library to Colligo Engage Windows
App in one of two ways:

e Using the Download New Site option
¢ Using the Connect to Engage option in Internet Explorer

When you add a site in Colligo Engage Windows App, the same site is also added to Colligo Engage

Outlook App. Similarly, if you add a site in Colligo Engage Outlook App, it is also added to Colligo Engage
Windows App at the same time.

Adding a Site in Colligo Engage Windows App

You can add a SharePoint list or library to Colligo Engage Windows App in one of two ways:
e Using the Download New Site option
e Using the Connect to Windows App option in Internet Explorer

Using the Download New Site Option (Stand-alone Interface)

To connect a site from the Colligo Engage Windows App stand-alone interface:
1. From the Site menu, choose Download New Site:

©) Colligo Engage = | [

Fie [site | view Help

Site: Syndhronize...

Synchronize All Fa

-~

(=]

-‘_:‘ﬁ Synchronize Multiple Sites. ..

.‘_;E'l

ca_| %2 Synchronize Pending Changes
| Site - - < d pad - | Filter =
2

Dowrload New Site...

Manage Sites...

@v_"i Mo Synchronization Activity /

The Download New Site dialog displays.
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» Download Mew Site ﬂ

Site: | <New Site> =l

URL: ||

Examples: htip:/fserver workspace
https: /fsecureserver fworkspace

—Server Authentication

Authentication Type: Auto-detect ;I

% Use default credentials
" Use the following credentials:

Uset narne: I

Passward: I

Download I Close |

3. Inthe Authentication Type drop-down menu, choose one of the following options:
e Auto-detect
¢ Windows Classic
¢ Windows Claim-based
e Form-Based
e ADFS2.0
o Office365
o Office365 by Prompt
4. Select either your default credentials, or supply other user-specific credentials.
5. Click Download.

The Select for Synchronization dialog displays the lists and libraries you have permissions for:

e Fxrm— Y
Select for Synchronization M

—Document Libraries and Lists

(" Synchronize all document libraries and lists

& Synchronize the following:

& ﬂ Announcements

[~ & calendar

™ [ElLinks

I il Private Documents

I~ [0 Product Lifecycle Dashboard
I~ [1lRelease Dashboard

[~ [ Shared Documents

I [ Site Assets

I (L Site Pages

[~ [l Tasks

Click the checkbox to enable or disable synchronization for

the specified list. [
CheckAl | Uncheckal | Fter.. |
Synchronize | Cloze l
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6. Check the boxes beside the lists and libraries you want to synchronize; use the Check All or
Uncheck All buttons if needed.
7. Click Filter to select which folders and views you want to synchronize.

The Select Filters for Synchronization dialog displays:

Select Filters for Synchronization l—ﬁ_.l

(™ Disable Synchronization for this Document Library

" synchronize Entire Document Library
(¥ Only synchronize content based on the following filters:

—Synchronized Folders-

BLa/
|1 Arakelyan et al v, Contoso LLC

| [Z3 ICE Co v= Contoso =

—Synchronized Views

1] All Documents

J My Matters add =
_'] Recent Documents

I oK Cancel

.

7. Choose from the following options:
o Disable Synchronization for this Document Library: choose this option if you do not want the

document library to be available offline.
¢ Synchronize Entire Document Library: choose this option if want to synchronize everything in the

specified document library.
¢ Only synchronize content based on the following filters: choose this option if you want to selec-

tively choose what folders and views are synchronized. In the Synchronized Folders and Syn-
chronized Views sections, select a folder or view you want to synchronize and click Add to move it
to the Selected Folders/Views column.

8. Click OK.

9. Click Synchronize. The site displays in Colligo Colligo Engage Windows App.

Using the Download New Site Dialog (Windows Explorer Interface)

To connect a site from the Windows Explorer interface:
1. Right-click the Colligo Engage node and select Download New Site from the contextual menu:
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"?-\ ! = - + Computer » Colligo Engage »
Organize »

»

4 . Favorites B
B Desktop
& Downloads

_ Colligo Intranet

%% Dropbox
5l Recent Places
a8 Computer
i &, BOOTCAMP (C)
I 3 DVD RW Drive (D:)
I = Macintosh HD (E:)
T —

I “! Metwark Expand
» [ Control Pan Open in new window
& Recycle Bin
Download New Site..,
I 4§ Flare =S
@;) 1 item
e ———————
h:

The Download New Site dialog displays.

2. Choose your Authentication Type and use your default credentials, or user-specific credentials.

3. Click Download.
The site displays under the Colligo Engage node in Windows Explorer. However, the site’s lists and
libraries are not synchronized at this point and display as greyed out in Windows Explorer.

4. To synchronize a list or library, right-click it and select Enable Synchronization. To select filters for
synchronization, right-click a list or library and select Filter Synchronization.

T 99909090900 e

"(‘-\ . = Colligo Engage » Colligo Intranet » - \i Seorch Colligo Infranct
Organize = = o @
|| Pictures & Name [
E Videos e :
) Customized Reports
A Tesza MacKinnon

[T Form Templates
M Computer e e |

& |Ef Shared Docurnent
BOOTCAMP (C: e
5 : e 4 Site Ass Open
=3 DVD RW Drive (D¥) _

. =4 Site Pag
= Macintosh HD (E!)

Disable Synchronization

@__:‘.- Colligo Engage F S it;le 1 v Enable Synchronization
[} Colligo Intranet et Filter Synchronization...
“' Netwark _ Copy SharePoint URL
@ Control Panel 3
- Default Metadata Values...
& Recycle Bin

.. Flare

t Shared Documents

After you have enabled synchronization and set your filters, you need to start the synchronization
process. You can do this in one of two ways:

¢ Right-click the Colligo Engage icon in the system tray and choose Synchronize All:
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Open Colligo Engage

¥ | Automatic Synchronization
Synchronize All
View Synchronization Status

Cancel Synchronization

Exit

e From the Site menu in the stand-alone Colligo Engage interface, choose one of the following
options:
o Synchronize Multiple Sites: choose this option to synchronize more than one site. In the
Synchronize Multiple Sites dialog, check your preferred sites and click Synchronize.
o Synchronize All: choose this option to synchronize all sites
o Synchronize Pending Changes: choose this option to synchronize changes you have made

Using the Connect to Windows App Button

1. Navigate to a SharePoint List or Library in Internet Explorer.
2. Click the Connect to Windows App icon on the toolbar.

B B v @ v Page Sefey~ Took~ @+|@)

Connect to Windows App

Site Actions - @ B Browse

Colligo Intranet » Home

The Download New Site dialog displays.

» Download New Site M

Site: | <New Site> |

URL: ||

Examples:  http:ffserver fworkspace
https: //secureserver/workspace

Server Authentication

Authentication Type: |Aub:u-detect j

(¥ Use default credentials
(" Use the following credentials:

|
| Close
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3. Inthe Authentication Type drop-down menu, choose one of the following options:
e Auto-detect
e Windows Classic
e Windows Claim-based
e Form-Based
e ADFS2.0
o Office365
o Office365 by Prompt
4. Select either your default credentials, or supply other user-specific credentials.
5. Click Download.

The Select for Synchronization dialog displays the lists and libraries you have permissions for:

Select for Synchronization Lﬁ

—Document Libraries and Lists-

(" Synchronize all document libraries and lists

i« Synchronize the following:

I~ &3 Announcements

I~ [ calendar

I~ [ElLinks

I~ | 53] Private Documents

I [l Product Lifecyde Dashboard
I~ [l Release Dashboard

I~ (53] Shared Documents

I |5 Site Assets

I |3 Site Pages

I~ [ Tasks

Click the checkbox to enable or disable synchronization for
the specified list.

chekAl | uncheckal | Frer. |

Synchronize | Close J

6. Check the boxes beside the lists and libraries you want to synchronize; use the Check All or
Uncheck All buttons if needed.
7. Click Filter to select which folders and views you want to synchronize.

The Select Filters for Synchronization dialog displays:
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Select Filters for Synchronization l_ﬁ_.l

(" Disable Synchronization for this Document Library
" synchronize Entire Document Library
(¥ Only synchronize content based on the following filters:

—Synchronized Folders-

BLA/
|3 Arakelyan et al v. Contoso LLC

| [Z3 ICE Co v= Contoso =

—Synchronized Views

1] All Documents

_] My Matters Add =
_'] Recent Documents

I oK Cancel

e

7. Choose from the following options:
o Disable Synchronization for this Document Library: choose this option if you do not want the

document library to be available offline.
¢ Synchronize Entire Document Library: choose this option if want to synchronize everything in the

specified document library.
¢ Only synchronize content based on the following filters: choose this option if you want to selec-

tively choose what folders and views are synchronized. In the Synchronized Folders and Syn-
chronized Views sections, select a folder or view you want to synchronize and click Add to move it
to the Selected Folders/Views column.

8. Click OK.

9. Click Synchronize. The site displays in Colligo Engage.

Editing Lists and Libraries

After you have added your site and chosen which lists and libraries you want to sync, you may want to
go back at a later time and edit your choices.

Any edits you make to the lists and libraries in Colligo Engage Windows App are also reflected in Colligo
Engage Outlook App.

You can edit your lists and libraries in one of two ways:

1. Right-click a list or library and select Enable Synchronization from the contextual menu.
2. Synchronize the site.

OR
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1. From the Site menu, choose Download New Site.

The Download New Site dialog displays:

5 Download New Site

2=

Site: | <New Site>»

=

2. From the Site drop-down list, choose which site you want to configure.

LURL: ||

Examples: http:/fserver fworkspace
https://secureserver fworkspace

—Server Authentication

Authentication Type: I.Auto-detect j

' Use default credentials
" Use the following credentials:

User name: I

Passward; I

Diownload I Close

The Synchronize Site dialog displays:

:_', Synchronize Site M

i |Colligo Intranet hd

URL: Ihtu:l:ﬂvs-spznltl

Examples: http:/fserver fworkspace
https: f/secureserver fworkspace

Synchronization Settings

 Only some lists will synchronize.
3 complete, 0 partial, 9 disabled

Configure... |

[~ perform full synchronization

Selecting this option synchronizes all site content, induding users, views
and templates. If your permissions on the site have changed, you
should select this option to get all the content you now have access to.
Selecting this option will result in longer download times.

Synchronize I Close

Colligo Engage

In the Configure Synchronization dialog, choose which Lists and Libraries you want to sync.

3. Click Configure.
4,

5. Click OK.

6. Click Synchronize.
2/22/2015
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Removing a Site
When you remove a site in Colligo Engage Windows App, the same site is also removed from

Colligo Engage Outlook App.
To remove a site from Colligo Engage Windows App:
1. From the Site menu, choose Manage Sites.
The Manage Sites dialog displays:

I -
Manage Sites ﬁ

Jhth:l:ffporiﬁl.mlligo.m

Configure... | Remove... Close

2. Select the site you want to remove and click Remove.

OR
1. Select the site you want to remove in the Site field:

>
©) Colligo Engage

File Site WView Help

Site‘.l . Colligo Intranet = |:Sind1ronize... x| W

Documents Mew - | Upload - | Filter -

= Shared Documents

2. From the Site menu, choose Remove Site:
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=
(@1 Colligo Engage

File | site | Yew Help
Site: = Synchronize "Colligo Intranet” Site... X
42 Synchronize Multiple Sites... »
ii# Synchronize Al Fq
|44 Synchronize Pending Changes
Doq ‘4 | Filter =
s Download New Site...
Manage Sites...
=sh Remove Site...
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SETTING SYNCHRONIZATION OPTIONS

In Colligo Engage Windows App you can set your Synchronization options to your lists and libraries sync
automatically.However, you can also perform manual syncs as well.
Configuring Automatic Synchronization Options

NOTE: the synchronization options you set in Colligo Engage Windows App also apply to Colligo Engage
Outlook App.

1. From the View menu, select Options.
The Colligo Engage Options dialog displays:

l

Storage

Storage location
]C:‘\Users'l,tlnaddnnon \AppData'Local\Coligar  Browse...

General

[ Prompt for properties when adding documents

[ Use current Windows(® appearance

Synchronization

[¥ Synchronize on startup

¥ Synchronize when list is viewed

¥ Synchronize when list is modified

¥ Enable combined check4n and sync

¥ Enable background synchronization

Background synchronization interval: IB‘D— minutes

v Automatically download lists to resolve Site Column values

Cancel | Ao |

e e

2. Inthe General section, you can turn on the prompt to record properties about the document by
checking the Prompt for properties when adding documents box. You can override this setting for
specific lists/libraries when you are configuring default metadata; see Setting Default Metadata.

3. Inthe Synchronization section, choose your preferred options:

¢ Synchronize on startup: choose this option if you want your lists and libraries to synchronize
every time the application starts

¢ Synchronize when list is viewed: choose this option if you want your lists and libraries to syn-
chronize every time you view a list or library

« Synchronize when list is modified: choose this option if you want your lists and libraries to syn-
chronize every time you modify a list or library

o Enable Combined check-in and sync: choose this option if you want to both check an item in and
sync it at the same time. If this option is not checked, the item remains checked out after the sync.

o Enable background synchronization: choose this option if you want to set the synchronization to
happen in the background on a time-specific basis, and enter your preferred time interval

2/22/2015 Copyright 2015 Colligo Networks, Inc. All rights reserved. Page 85 of 113

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage

o Automatically download lists to resolve Site Column values: if you have lists that reference
other lists (look-ups), checking this option ensures the related referenced lists are also down-

loaded
NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be
accessible to you, or the synchronization options may be greyed out.

Synchronizing Sites Manually
After you have added your sites, you may want to synchronize them manually:
1. Click the Synchronize menu to display the options:
1@ coltin Engage L B e |

File Site Wiew Help

Site: [y Coligo Intranet = ;‘;.Sy_nd'lronize... -

B Synchrenize "Colligo Intranet” Site...

-

iff] Synchronize Multiple Sites. ..

| Documents “| 43 Synchronize Al Fo

iran Synchronize Pending Changes

5 Download New Site...

= Shared Documents

(‘3:3' Last Synchronization! 10/1/2014 7:32:35 PM

"

2. Choose from the following:
« Synchronize Site: select this option to synchronize the site currently displayed
¢ Synchronize Multiple Sites: select this option to display all sites and choose which ones you want

to synchronize
¢ Synchronize All: select this option to synchronize all sites
¢ Synchronize Pending Changes: Select this option to synchronize any lists or libraries containing

changed content
The Synchronization In Progress dialog displays for any of the above options:
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s 5
Synchronization In Progress... [_thJ
Site List: Site: 4 Colligo Portal
% | Coligo Portal Server: »9 http: ffportal. colligo.com

Synchronization Activity

Current List: E} Shared Documents

Status: Receiving... Office2010QA. doc (990 KB)
Received: 13 of 96 Sent: 0 of D

Working...

Cancel

[~ Close this window when synchronization completes

The Status field displays the name and size of the file being synchronized, as well as if the file is being
sent or received.

Viewing Pending Changes

When you are not connected to your SharePoint server, any changes and edits you make are listed in
the Pending Synchronization Changes dialog. You can review the changes you've made before
synchronizing them.

From the View menu, select View Pending Changes. The Pending Synchronization Changes dialog
displays any items that will be synchronized the next time you are connected to the network. You have
the option in this dialog to right-click an item and select discard if you want to revert the change.

Completing a Full Synchronization

Several of the synchronization dialogs have a Perform Full Synchronizationoption. This option means
that additional information is downloaded, including definitions for Sites, Lists, Views, and Content
Types, plus other site content that may not be retrieved during other standard sync processes.

Viewing and Resolving Synchronization Issues

When a sync error occurs, the item where the error occurred is highlighted and an error icon is overlaid
over the file type icon.

There is also a dialog that pops up from the system tray icon to indicate a sync error; you can click the
pop up for more information about the :

{4 Sync Error
A sync error has occurred.
Please click this message for more informaticon.

In addition, the View Sync Issues button changes color so it is more visible.

You can click the View Sync Issues button to display the Sync Issues pane:
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-
@ Colligo Engage

fle  Site View Help
Site: |, Firestarter Portal

| 2 synchronize.., = | @ View Sync Issues (1)

Firestarter Portal = Marketing > Proposals

Marketing

Site Content
[E} Finance
[ER Form Templates
By
[} Manufacturing
4 Marketing
% Brochurss
L% Campaigns
% Datasheets
4 [f Graphics
L% Logos
¥ Market Research
E Proposals

BEEEEEEHS

Hew v | Upload ~ | Fiter ~ view: | All Documents  ~ || 7]
Mame Modified Modified By Author  Related Company  Person/Group  Product  Published

it workbook Ldex  10/4/20147555AM  Dawid Jackson  RickR... “Yes ]

Sync Issues *
Issue Item Site List Folder

;_h Confiict ﬁ Workbook L xlsx Q Firestarter Portal E—’.{{] Marketing i Proposals

4| | »

‘ @ Last Synchronization: 10/4/2014 7:55:46 AM |

Colligo Engage

The sync error displays the type of issue, the item name, site, list, and folder. You can use these columns
to sort your syncissues.

To resolve a syncissue, right click the line item and choose View Conflict.

The Resolve Synchronization Conflict screen displays:

Options

Options

Content Type: | Document

Content Type: | Document

Pmper‘i:’les

|Te1-t:rhea:i

————————

Dl F——

I_DIadc;on

Last Update

Last Update

Editor:

Version: 1.7

David Jackson
Modified: 3/12/2014 1:56:08 PM

Editor:

Jerry McKenzie
Modified: 3/12/2014 1:55:51 PM

Version: 1.8

You can choose to merge the two versions, or choose either the local or server version to resolve the

conflict.
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VIEWING, EDITING, AND CREATING NEW CONTENT IN COLLIGO ENGAGE WINDOWS

APP (STAND-ALONE INTERFACE)

After you have added your sites and synchronized your lists and libraries, the content is available offline
(when you are not connected to your SharePoint network). You can now view and edit SharePoint items,

create new content, check items in and out of SharePoint, as well as rename and delete items, from the

Colligo Engage Windows App interface.

NOTE: If you have set certain SharePoint locations as upload-only in Colligo Engage Outlook App, the

content of those locations is not available to you when offline .

Offline locations display as follows:

7
(€ Colligo Engage
File Site View Help
Site: [y Firestarter Portal = | z Synchronize.., | Wy
—1 Firestarter Portal = Marketing
EE" Marketing
Site Content || ew ~ | Upload + | Filter ~
Ej' | Name Modified Modified By Author
'—_§ [ Et Brochures 9/19/2013 3:38 AM Mary White
I:"J : Et Campaigns 9/19/2013 9:38 AM Mary White
P B Market . E: Datasheets 9/19/2013 938 AM Mary White
Bt L¥ Graphics 9/19/2013 10:35 AM  David Jackson
B Camign: Et Market Research  9/19/2013 9:37 AM Mary White
[ Datashasts Dt Proposals 9/159/2013 9;38 AM Mary White
4 [F Graphics CF strategy 9/19/2013 9:37AM  Mary White
D Logos
8 Market Research
8 Proposals
[ strategy

Upload-only locations display as follows:

€ Colligo Engage

Eile Site  Wiew Help

Site: |y Coligo Intranet = | ESEnd'lromze... ] Wy

Colligo Intranet = Shared Documents

BOOSD

|
| =N Shared Documents

— i This listis currently configured for upload only. Click here toe

| Site Content : i
| L_j i Renork | Share 5 document with the team by adding it to this document

':_1] . it | Mew = | Upload = | Filter =

« [Gf Shared Documents || piame Modified N
[ Brisfings | {4 Briefings 10/1/2014 7:46 PM T

The Tree View in the stand-alone interface allows you to view content more dynamically and to move and
copy content between folders in the same SharePoint site using drag-and-drop. You can change the view
by enabling or disabling the Tree View option in the View menu:

2/22/2015 Copyright 2015 Colligo Networks, Inc. All rights reserved.

Not to be reproduced without permission. Learn more at www.colligo.com.

Page 89 of 113



(€ Colliga Engage

Ele Site | View | Help
sier [l C "}L View Sync Issues | &
Shared Documents
View Pending Changes. .. }cuments
Documenl @ Show Filter Chaices with the t=am by adding it to this doou
b | Filter =
Refresh F3 i Fﬁcﬁﬁed
= Shared D —— 10/1/2014 7:46 PM
- 122044 Ben... 9/26/2014 10:22 AM
Tree View
60ct20 ) 2014 10528 Al

I -
M| ACME Quote-Word 2003.... 5/7/20146:31FM

Colligo Engage

NOTE: you cannot enable or disable synchronization of document libraries or lists while Tree View is
enabled. If you want to do this, you must turn off Tree View and work in List View.

NOTE: If the Tree View option is not available to you, it has been disabled by your IT Administrator.

The following icons are overlaid on file type icons in the sync pane to indicate the following item statuses:
Sync error:

Sync pending: @
Checked out by me:

Checked out by another user:

Declared Record: \E\

Viewing Content

To view an item in a library/folder, double-click it. It opens in the program native to the item type. You
can then edit the item if preferred.

If Tree View is enabled, you can expand and contract folders in the left pane to navigate to the
SharePoint location you are looking for. The folder that is highlighted in the Tree View indicates the
SharePoint location you are currently are viewing.
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8 —
€ Colligo Engage l =t g
File Site Wiew Help
Site: |y Firestarter Portal = | sznchmnlze... | @
[ Firestarter Portal > Marketing > Graphics
| =8 Marketing
S Confeu) 21| tiew ~ | Upload ~ | Filter ~ view: | All Documents - | [
’:'j il Mame Modified Modified By Author  Related Company  Person/Group  Product  Publish
% : C% Loges 9/18/2013 10:36 M David Jackson
|:_’1 s |k firestarter.jpa 9/19/2013 10:40 AM  David Jackson
. Marke:mg . 5] frestarter_blue.... 3/5/20142:19PM  David Jackson Yes
% Brochures || firestarter_blue.., 9/13/2013 10:40AM  David Jackson
C§ Campaigns | firestarter_purp... %/19/2013 10:40 AM  David Jackson
[§ Datashests | firestarter_purp... 9/18/2013 10:40AM  David Jackson
I [ firestarter_sm.jpg 9/19/2013 10:40 AM  David Jackson
% Markst Research ."5 frestarter_sm_... 9/19/2013 10:40 AM  David Jackson
% Proposals 14 Helen Jones_09... 10/8/2013 11:29AM  David Jackson Excite
L% strategy
5 | A |z
i @ Last Synchronization: 10/4/2014 7:58:04 AM
L |

Viewing Item Version History

If a library has versioning enabled, you can view an item's version history by choosing the Version
History option in the right-click contextual menu:
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-
@ Colligo Engage
Fle Site View Help

site: [} Firestarter Portal ~ | 7 Synchronize... = | & V= oy

Firestarter Portal = Marketing > Graphics

Marketing
Mew ~ | Upload - | Filter = Wi
Name Modified Modified By Author  Related Company  Person/Group

9/19/2013 10:36 AM  David Jacksan

o o o oV

; E Edit Properties...
F ﬂ Marketing i

% Brochures = Cpen with Windows Phota Viewer

L% campaigns @1 Edit with Paint

% Datasheets
I [§ Graphics |e=l| firestarter_sm.jf Copy

[[§ Market Research =] frestarter_sm_, Paste

¥ Proposals 14 Helen Jones_0g| '-b CheckIn

Strategy ;
B sales &) Discard Check Qut
5 |f=;j Version History
@ i
5 Send As Link
= Send As Attachment
% #,  Copy SharePeint URL
8
CE| 8, Copy SharePgint Doc ID URL
= = Rename
¥ Delete
Create Shortout

| @ Last Synchraor

NOTE: this feature is enabled only when you are connected to your SharePoint server. If you are offline,
the option is greyed out.

The Version History window displays:

No Maodified Meodified By Size Comments
0.4 2014-09-129:45 Rick Ramsay 18 KB
03 2014-09-10 6:02 Rick Ramsay 18 KB
02 2014-09-105:12 Rick Ramsay 35 KB
01 2014-08-13 529 Rick Ramsay 35 KB

Click on a version number to open the SharePoint version of the item.

Emailing a Link or an Attachment

You can email a link to a SharePoint item or you can send the item as a physical attachment.
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Choose either Send As Link or Send As Attachment from the contextual menu:

=
€ Colligo Engage

Fle Site View Help

Site: [,y Firestarter Portal = | :Sgnchromze... w| Ky View

Firestarter Portal > Marketing > Graphics

—
| ;_:‘l.; Marketing
Site Content Mew + | Upload - | Filter =
=} finance Name Modified Modified By Author  Related Comp
% RN % Loges 9/19/2013 10:36 AM  David Jackson
P Mar‘rce&mg : restarter_bly o4 Edit Properties...
% Brochures firestarter bl =] Open with Windows Photo Viewer
Y | firestarter_puy .
¥ Campaigns E @) Editwith Paint
[ Datashests || firestarter_pu Gel| Editwith Pain
| % Graphics [=] firestarter_sm Copy
% Market Research = firestarter_sm -
Proposals -1 Helen Jones_o
gstrcltegy Ly CheckIn
cale |i# Discard Check Out

5,5

[Q \Version History

[ Send As Link
L_E Send As Attachment
FHlEv: & Copy SharePoint URL
(65 staf 9, Copy SharePoint Doc ID LRL
_E Rename
¥ Delets

Create Shortout

Choosing one of these options launches your mail client with the link or physical attachment already
present.

Creating a Shortcut to an Item

You can create a shortcut to any SharePoint item from the contextual menu:
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(€ Colliga Engage

Eile Site Wiew Help

Site: |4 Firestarter Portal = | ::.SInd'u'omze... = | &

=T

Firestarter Portal = Marketing > Graphics

Marketing

Site Content

«  [Cf Marketing
% Brochures
¥ Campaigns
¥ Datasheets
I [# Graphics
% Markat Research
¥ Proposals
¥ strategy

HEEEASHSS

Mew - | Upload - | Filter =

Mame

Et Logos

=] firestarter_blue..,
| firestarter_purp...
|= firestarter_purp...
[=] firestarter_sm.jpg
= firestarter_sm_...
- Helen Jones_03,..

) firestarter_blue....

Modified
9/19/2013 10:35 AM

Modified By

Edit Properties. ..

Author

(=) Open with Windows Photo Viewer

Edit with Paint

Copy

ChedcIn
Discard Check Cut

Wersion History

Send As Link

Send As Attachment

Copy SharePoint URL

Copy SharePoint Doc ID URL

Rename

Delete

| Create Shortout

Related Company

David Jackson

The default location for the shortcut is your desktop.

Editing Content

Colligo Engage

To edit an item in a library/folder, double-click it to open the item in its native program. Edit the item as
preferred, save it, and close it.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If another user has opened the document, edited it, and uploaded it to SharePoint, and you try to
upload the same document with your changes, the following dialog displays:
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Document

':' StratMLFAQ20031027.doc = s StratMLFAG20091027.doc
d={ M Mord-97 - 2003 Dooument %él Microsoft W 103 Document
—i o s =1 7405 (75, )

Microsoft Word

Folder Folder

&=/ =Y

Properties Properties

Content Type: | Demo Document - ContentType: | Demo Document

Name = Hame *
StratMLFAQ20051027.doc StratMLFAQ20091027.doc

Jile et
StratMLFAQ20091027.doc StratMLFAQ20091027.doc

Correspondence List (‘_AJLrE_mmleme List

Audio Yisual Audio Visual

Market Sector Market Sector

Defence + Justice + Custodial Defence + Justice + Custodial

| Apply . | Apply

Last Update Last Update
Editor: Tessa Mackinnon Editor: Tessa MackKinnon

Modified: 07/09/2011 5:12:31 PM Modified: 07/09/2011 5:13:25 PM

You can click Open to view the edits in each version, and then click one of the following options:

e Choose Local Version: if you choose this option, the version on your local machine overwrites the
current version on SharePoint

o Merge Versions: If you choose this option, a wizard displays and walks you through a process to
choose the changes you want to keep or discard

« Choose Server Version: if you choose this option, the version on SharePoint does not change;
you are effectively discarding your version
Editing Item Properties
To edit the properties of an item:
1. Right-click the item and choose Edit Properties:
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=
(©) Colligo Engage
Ble Site Wew Help
Site: [y Frestarter Portal = | zSEHd'u'omze... v | Wy
- Firestarter Portal > Marketing > Graphics
e Marketing
Site Content Mew - | Upload = | Filter ~
:j' Mame Maodified Modified By Author  Related Company
L—}' : Et Logos 9/19/2013 10:36 AM  David Jackso
El____; I B Skl -
+ [ Madce!;ing- firestarter_bil|# it Broperties. .,
[ Brochuras = firestarter_bl =] Open with Windows Photo Viewer
4 ] firestarter -3
L% Campaigns s M@l Edit with Paint
[f Datasheets || firestarter_py
i [ Graphics [=] firestarter_sn Copy
[F Markst Research = firestarter_sn
¥ Proposals - Helen Jones_{ -
SomE {5 CheckIn
B sale |y Discard Check Out
% Ej Version History
B = Send As Link
B styke Send As Attachment
T ver & Copy SharePoint URL
EE= % Copy SharePoint Doc ID URL
Rename
3¢ Delete
Create Shortout -
L.

The Edit Properties dialog displays.

2. Edit as preferred and click Close.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

Checking Items In or Out

To check an item in or out, right-click it and choose Check Out/In. The Check In option only displays if

you have previously checked the item out.

Once you have checked an item out, the Check Out icon is overlaid on top of the document type icon, so

users can see that the item is being edited:

After you have checked the item out, you can open it, edit it, and then check it back in to the list/library.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If you try to check out an item that has been modified in SharePoint and not synchronized, the

following message displays:
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Check Out Ttems) [

The operation completed with errors,

Item Message Description

Viersion Mismatch  The version of the file on the server is different from the l..,

Cloze

Close the dialog, synchronize the site so you have the most up-to-date version of the document, and
then perform the Check Out operation again.

To avoid the above conflict, select the combined check-in and sync option as described in Setting
Synchronization Options.

Renaming Items
To rename an item:

1. Right-click it and select Rename.
2. Theitem name becomes editable. Edit as preferred, and press Enter to complete the change.

The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot rename an item if it is checked out by another user. If the item is checked out, a red
Check Out icon displays on the item.

Deleting Items
To delete an item, right-click it and select Delete.
The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot delete an item if it is checked out by another user. If the item is checked out, a red
check-out icon displays on the item.

Creating New Content

In addition to editing existing content in SharePoint, you can also add new content to your synchronized
lists and libraries.

You can add items to Colligo Engage Windows App in one of the following ways:

o Create new documents from the Colligo Engage Windows App menus
¢ Upload existing content
e Drag-and-drop or copy-and-paste content

Adding a New Document to a List/Library

To add a new document to a list or library:

1. Select the list or library you want to add the document to and click the New menu and select your
preferred document type from the drop-down list:
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-
(€ Calligo Engage
i g gag

File  Site  Wiew Help
Site: [y Firestarter Portal = | :Sgnd'lromze... - | Wy, Vien
| Firestarter Portal = Marketing > Graphics
| =8 Marketing
Site Content New v || Upload ~ | Filter =
,:'j AR Document Madified Madified By
% e r s 9/18/2013 10:35 AM  David Jackson
[ Manufacturing Email 3
“ Marketing 3/5/2014 2:19PM David Jackson
[ Brochures L4 Folder 9/19/2013 10:40 AM  David Jackson
[ Campaigns .'g firestarter_purp... 9/19/2013 10:40 AM  David Jackson
[# Datashests |= firestarter_purp... 9/13/2013 10:40 AM  David Jackson
i [% Graphics ;, firestarter_sm.jpg 9/19/2013 10:40 AM  David Jackson
% Markst Ressarch = firestarter_sm_... 9/13/2013 10:40 AM  David Jackson
¥ Proposals 1] Helen Jones_09... 10/9/2013 11:29 AM  David Jackson
C¥ strategy
B e ke

The Create New Document dialog displays:

-
] Create Mew Document

=

Site Templates | Other
W= I
template

Mew Document

Please enter a name for this new document:

| creae |

[ Concel |

3. Enter a name for the document, and click Create.

The Edit Properties dialog displays. This is where you can record information about the document

that you are adding to SharePoint.

4. Edit the Edit Properties dialog as preferred.

2/22/2015

Not to be reproduced without permission. Learn more at www.colligo.com.

Copyright 2015 Colligo Networks, Inc. All rights reserved.

2. Choose your document type from the Site Templates tab or the Other tab.

Colligo Engage

Page 98 of 113



(€ Edit Properties B
Options
Content Type: | Document -
_Pruperties
MName Value
+ Name ‘New Document docx
Title
Author
Related Company
Product ]
Published

oK | Cancel I

5. Click Create. The document is added to the SharePoint location.

Using the Upload Documents Dialog

To add an existing document to a list or library:

1. With thelist or library you want to add the document to selected, click the Upload menu, and

choose Upload Documents:

r@_\ Calligo Engage
Ele Site  View Help
Site: |y Firestarter Portal ~ | ESEd'u'omze... - Wy, ien
[~ Firestarter Portal > Marketing > Graphics
| __ﬂ Marketing
Site Content Mew ~ ||upload - || Filter -
'::5_ i ':_'E MName |_} Upload Documents |' Madified By Author  Related
Eﬁ P % Loges 9/19/2013 10:36 AM_ David Jackeon
. Mar‘netlrlg - firestarter_blue.... 3/5/20142:19PM  David Jackson
7% Brochures = firestarter_blue... 9/19/2013 10:40 AM  David Jackson
O Campaigns ."g firestarter_purp... 9/19/2013 10:40 AM  David Jackson
8 Datashasts |e=| firestarter_purp... 9/19/2013 10:40 AM  David Jackson
4 [% Graphics |e=| firestarter_sm.jpg  9/19/2013 10:40 AM  David Jackson
[% Logos = firestarter_sm_... 9/13/2013 10:40 AM  David Jackson
¥ Market Research 1 Helen Jones_0%,.. 10/9/2013 11:29 AM  David Jackson
% Proposals
% strategy
= -

The Upload Documents dialog displays.
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2. Browse to the document that you want to upload, and click Open. To select more than one doc-
ument, use Ctrl + click.
3. The Edit Properties dialog displays. Edit as preferred and click Create.

The document is added to the SharePoint location. If you have selected more than one document,
any properties you assign apply to all items.

Dragging-and-Dropping Content
You can drag-and-drop one or more files or complete folder structures into Colligo Engage Windows App
from your desktop or from other directory locations.

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your pre-
ferred SharePoint location in Colligo Engage Windows App .

2. The Edit Properties dialog displays. Edit as preferred and click Create. The file or folder is added to
the SharePoint location. If you have selected more than one document or a folder, any properties
you assign apply to all items.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; cut is not supported in this feature.

Moving or Copying Content within SharePoint

You can move or copy content from one location in SharePoint to another location, through the Colligo
Engage Windows App interface.

NOTE: This feature is disabled by default. Contact your IT Administrator.
1. Select one or more files in a library or folder, and drag-and-drop it to another folder.

The Edit Properties dialog displays.

2. Edit as preferred and click Create.
The following dialog displays:

I Ny
(€ Move or Copy l#_?ﬂ

L‘H Warning:

Afile’s version history, last modified time, and creatorinformation are deleted during the
Move or Copy action. The Maove action deletes the ariginal file(s).

Move | Copy |

s o

3. Click Move or Copy. Note that no version history, timestamps, or original author information is pre-
served in either the Move or Copy action. If you choose to move an item, the original file is deleted.
In addition, any metadata associated with the original file will not be preserved and you will need to
enter new metadata for the item.
NOTE: You cannot move an item that is checked out by another user. If you attempt to do this, the
following error message displays:
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There were errors validating the move operation, Hover your mouse
aver an item to see the details.

Copy Cancel

If you hover your mouse over the item, a message displays telling you who has the item checked out.

Colligo Engage

That user needs to check the item back in before you can move the item.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; move is not supported in this feature.

Searching Content

If the search feature is enabled, you can enter a term in the search field and it will search the entire
SharePoint site that you are currently viewing:

r
) Colliga Engage l ey e[Sl
File Site View Help
Site: [ Firestarter Portal 7| g Synchronize... = | Wy Search on SharePoint: { ’
— Firestarter Portal > Sales
EE Sales
| Documents | Mew = | Upload = | Filter = vieve: | All Documents

® Finance Mame Madified Maodified By
Et Contracts 9/19/2013 5:39 AM Helen Jones
H Presentations 9/19/2013 9:39 AM Helen Jones
Et Pricelists 9/19/2013 9:35 AM Helen Jones
E‘ Reports 9/19/2013 9:35 AM Helen Jones

" Sales E‘ Sales Tools 9/19/2013 9:35 AM Helen Jones

'~ Lmid- el Falnlm P B Animiands 44.77 ARA | TR e P )

When you enter a term and press Enter, or click the magnifying glass icon, your web browser launches

and the search results for the site display.

Because this search yields results from your SharePoint server, this feature is only supported when you
are connected to your server. When you are offline, this function will not work.
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VIEWING, EDITING, AND CREATING NEW CONTENT IN COLLIGO ENGAGE WINDOWS
Aprp (WINDOWS EXPLORER INTERFACE)

After you have added your sites and synchronized your lists and libraries, the content is available offline
(when you are not connected to your SharePoint network). You can now view and edit SharePoint items,
create new content, check items in and out of SharePoint, as well as rename and delete items, from the
Colligo Engage Windows App interface.

NOTE: If you have set certain SharePoint locations as upload-only in Colligo Engage Outlook App, the
content of those locations is not available to you when offline .

Offline locations display as follows:

, [ESRECNE=S)
@Uv“._:t « Colligo Engage » Firestarter Portal | 3 | Marketing » - | "?| | Search Marketing P
Organize * =~ 0 @

= Libraries (22
__~: Documents 1 Brochures I Campaigns
-.,? Music
il Mew Library
] Picires Datasheets t Graphics
B videos
A Tessa MacKinnon Market Recearch I Proposals

% Computer
&, BOOTCAMP (T3
5 DVD RW Drive (D:)
—a Macintesh HD (E:)
© Colligo Engage

&ii MNetwork

(5 Control Panel

£ Recycle Bin

Strategy

- = o=

T

Flare

t 7 items

Upload-only locations display as follows:
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@Uv| 5 ¥ Computer » Colligo Engage » ColligoIntranet »

~ | 4]

Segrch C

=]

Organize =

Bl Desktop
Libraries
-“f_\ Customize
“t| Documents d Reports
.»J':‘ Music
=i New Library
b=l Pictures

B videos

© Colligo Engage
4 Collige Intranet

Test -

& Firestarter Portal
€l Metwork
[E cantral Panel
7 items

3

1

Shared
Documents

Site Assets

The following icons are overlaid on file type icons to indicate the following item statuses:

e Syncerror: | ®£

e Sync pending:@
e Checked out by me: @

e Checked out by another user:

e Declared Record: ’E‘

Viewing Content

Colligo Engage

To view an item in a library/folder, double-click it. It opens in the program native to the item type. You

can then edit the item if preferred.

Emailing a Link or an Attachment

You can email a link to a SharePoint item or you can send the item as a physical attachment.

Choose either Send As Link or Send As Attachment from the contextual menu:
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Organize «

B Desktop
4 Libraries
@ Documents
J" Music
gﬂ New Library
|k=| Pictures
ﬂ Videos
A Tessa MacKinnon
L Computer
&, BOOTCAMP (C)
45 DVD RW Drive (D:)
= Macintosh HD (E:)
f‘ Collige Engage
.4 Collige Intranet
.y Firestarter Portal
eh Metwork
[E Contral Panel
| Workbooklxlsx

Edit Properties...

Open with Microsoft Excel
Edit with Microsoft Excel

Check Cut

Copy SharePoint URL
Copy SharePoint Doc ID URL

Copy
Paste

Send As Link
Send As Attachment

Create Shortcut

Rename

Delete

Colligo Engage

Creating a Shortcut to an Item
You can create a shortcut to any SharePoint item from the contextual menu:

=% « Firestarter Portal »

Organize

B Desktop
4 Libraries
@ Documents
J“ Music
gﬂ Mew Library
|= Pictures
= videos
A Tessa MacKinnon
1M Computer
&, BOOTCAMP (C)
<3 DVD RW Drive (D%)
= Macintosh HD (E:)

f‘ Collige Engage

L.y Collige Intranet
..y Firestarter Portal
e‘l Metwork
[E Contral Panel
EEE Workbookl.xlsx

Editing Content

Edit Properties...

Open with Microsoft Excel
Edit with Microsoft Excel

Check Out

Copy SharePoint URL
Copy SharePoint Deoc ID URL

Copy
Paste

Send As Link
Send As Attachment

Create Shortcut

Rename

Delete

To edit an item in a library/folder, double-click it to open the item in its native program. Edit the item as

preferred, save it, and close it.

The changes are uploaded to SharePoint the next time the list/library is synchronized.
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NOTE: If another user has opened the document, edited it, and uploaded it to SharePoint, and you try to
upload the same document with your changes, the following dialog displays:

Document

Tk StratMLFAQ20091027.doc 7. STatMLFAQ20091027.doc
_’_ii B ft Word-97 - 2003 Dooument % Microsoft Word 3 Docament

W

ES)

@ Microsoft Word Microsoft Word

Folder Folder

=1 =T

Properties Properties

Content Type: Demo Document : Content Type: | Demo Document

Name = Hame *
StratMLFAQ20051027.doc StratMLFAQ20091027.doc

Jitie e
StratMLFAQ20091027.doc StratMLFAQ20091027.doc

Correspondence List i
Audio Visual Audio Visual

Market Sactor Market Sector
Defence + Justice + Custodial Defence + Justice + Custodial

| Apply Revert | | Apply | Revert

Last Update Last Update
Editor: Tessa Mackinnon Editor: Tessa MackKinnon

Modified: 07/053/2011 5:12:31PM Modified: 07/03/2011 5:13:25 PM

You can click Open to view the edits in each version, and then click one of the following options:

e Choose Local Version: if you choose this option, the version on your local machine overwrites the
current version on SharePoint

¢ Maerge Versions: If you choose this option, a wizard displays and walks you through a process to
choose the changes you want to keep or discard

o Choose Server Version: if you choose this option, the version on SharePoint does not change;
you are effectively discarding your version

Editing Item Properties

To edit the properties of an item:
1. Right-click the item and choose Edit Properties:
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Crganize «

B Desktop
= Libraries
'3 Documents
J" Music
il Mew Library
[e=] Pictures
B Videos
A Tessa MacKinnon
Lo Computer
£, BOOTCAMP (C)
L3 DVD RW Drive ([:)
= Macintosh HD (E5)
© Cellige Engage
.4y Collige Intranet
..y Firestarter Portal
eﬁ Metwork
[E Crntral Panel
s

ﬂ:.:a
=

WorkbookL.xlsx

Edit Properties... |

Open with Microsoft Excel
Edit with Microsoft Excel

Check Out

Copy SharePoint URL
Copy SharePeint Doc ID URL

m

Copy
Paste

Send As Link
Send As Attachment

Create Shortcut

Rename

- Delete

The Edit Properties dialog displays.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

Checking Items In or Out

2. Edit as preferred and click Close.

To check an item in or out, right-click it and choose Check Out/In. The Check In option only displays if
you have previously checked the item out.

Once you have checked an item out, the Check Out icon is overlaid on top of the document type icon, so
users can see that the item is being edited:

After you have checked the item out, you can open it, edit it, and then check it back in to the list/library.
The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If you try to check out an item that has been modified in SharePoint and not synchronized, the
following message displays:

Check Out Itemis)

==

The operation completed with errors,

Item

*  Colliga Style Sheet. docx

Description
The versian of the file on the server is different from the |..,

Message
Version Mismatch
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Close the dialog, synchronize the site so you have the most up-to-date version of the document, and
then perform the Check Out operation again.

To avoid the above conflict, select the combined check-in and sync option as described in Setting
Synchronization Options.

Renaming Items
To rename an item:

1. Right-click it and select Rename.
2. Theitem name becomes editable. Edit as preferred, and press Enter to complete the change.

The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot rename an item if it is checked out by another user. If the item is checked out, a red
Check Out icon displays on the item.

Deleting Items

To delete an item, right-click it and select Delete.
The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot delete an item if it is checked out by another user. If the item is checked out, a red
check-out icon displays on the item.

Creating New Content

In addition to editing existing content in SharePoint, you can also add new content to your synchronized
lists and libraries.

You can add items in the Windows Explorer extension of Colligo Engage Windows App in one of the
following ways:

o Add a new document from within the Colligo Engage Windows App Windows Explorer interface
Upload existing content

Drag-and-drop or copy-and-paste content

Use the File > Save As command

Adding a New Document to a List/Library
From within Windows Explorer, you can create and add a new document to a SharePoint location:
1. From the File menu, choose New > New Document:
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o,

=(C§ < Firestarter Portal » Marketing » Proposals

Edit View Tools Help
Mew r Document g~ O @

Image

Upload Decuments

Email bookd xlsx
Create shortcut

Delete Folder

Rename
Properties =
Close

T L WEGRtGERHDTET
@ Colligo Engage

m

L.g ColligoIntranet
L.y Firestarter Portal
E} Finance T
E—j Ferm Templates
B
E_j Manufacturing
Marketing
[P Sales =

I 1 item

NOTE: if you cannot see the File menu, press Alt key to display it.

The Create New Document dialog displays:

P =T B
|| Create New Document g
Site Templates | Other

template

Please enter a name for this new document:

Mew Document

[ ceae | [ concet |

2. Choose your document type from the Site Templates tab or the Other tab.
3. Enter a name for the document, and click Create.

The Edit Properties dialog displays.
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(© Edit Properties L@ﬂ

Options

Content Type: | Document -

Properties

Name Value

« Name ‘New Document docx

Title

Author
Related Company

0K | Cancel |

e =

4. This dialog is where you can record information about the document. Edit as preferred.
5. Click OK. The document is added to the SharePoint location.

Using the Upload Documents Dialog

From within Windows Explorer, you can upload existing documents to your preferred SharePoint
location:

1. From the File menu, choose Upload Documents:
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]

Upload Decuments

5 S5 Workbookl xlsx
Create shortcut B

Dielete

Rename

Properties —

—a Macintosh R0 (E]

Close ‘
?' Colligo Engage ‘

m

s Colligo Intranet

o Firestarter Portal

E Finance T
[} Form Templates

=)

Q Manufacturing

Eft Marketing

[ Salec 5

l 1 item

NOTE: if you cannot see the File menu, press the Alt key to display it.

The Upload Documents dialog displays.

2. Browse to the document that you want to upload, and click Open. To select more than one doc-

ument, use Ctrl + click.
3. The Edit Properties dialog displays. Edit as preferred and click OK.

The document is added to the SharePoint location. If you have selected more than one document,
any properties you assign apply to all items.

Dragging-and-Dropping Content
You can drag-and-drop one or more files or complete folder structures into File Manager from your
desktop or from other directory locations:

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your pre-
ferred SharePoint location in the Windows Explorer extension of Colligo Engage Windows App.
2. The Edit Properties dialog displays. Edit as preferred and click OK.

The file or folder is added to the SharePoint location. If you have selected more than one document
or a folder, any properties you assign apply to all items.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; cut is not supported in this feature.

Using the File Save As Command

You can use the File > Save As command from integrated programs to save directly into any of the
SharePoint lists or libraries you have connected to Contributor File Manager:
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1. Inyouropen document, select File > Save As.
2. Inthe Save As dialog, navigate to your SharePoint location, edit the file name as needed, and click

Open:

i My
CE] save As M
@le » Computer » Colligo Engage » Firestarter Portal » Marketing » - | £y | | Senrch Marketing = |

Organize « == - (7]
b 4} DVD RW Drive (D3) (=] -
[* g Macintosh HD (E:) I Brochures I Campaigns

4 (@) Colligo Engage

I> iy Colligo Intranet I E=Y
4, Firestarter Portal I Batishects 1 GEEhiEs
[} Finance

E_j ko, Templates I Market Research I Proposals

B
I Strategy il

m

[} Manufacturing
i»___Marketing
'__l Calmm

[l

File name: Docl

Save as type: IWord Document

Authors: Tessa MacKinnon Tags: Add atag Title: Add a title

[ Save Thumbnail

Tools [ Save ] I Cancel

4 Hide Folders

3. The Edit Properties dialog displays. Edit as preferred and click Close.
The document is added to the SharePoint location.
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SETTING DEFAULT METADATA

If you want to tag all documents and items that you add or upload to a list or library with the same
metadata, you can set default metadata values through the Colligo Engage Windows App interface:

1. From the File menu, choose Default Metadata Values.
The Default Metadata Values dialog displays:

Default Metadata Values L&J

|Contoso LLC = |

Mame Value Inherited From Apply To

_"J Content and Structure Reports
3] Customized Reports
I
\43] Drop Off Library
|23] Form Templates
53] Images

11| Reusable Content
3] Site Collection Documents
(3] Site Collection Images
5] Style Library

] Workflow Tasks

Add... Heer When adding documents, prompt for properties:
" Always
I Inherit propagating values from parent items ™ Mever
I Clear locally-defined values on all child items (& According to application global settings

OK | Cancel Apply

2. Select the site and library/list that you want to configure.
3. To add a metadata tag, click Add.

The Add Default Metadata Properties dialog displays, displaying the metadata field options that are
set in the document library in SharePoint.

r o
Add Default Metadata Properties @

Descriptis
- ription

Title
™

l v Propagate these default metadata values to
subfolders

4. Enteryour preferred tags and click Add.
5. If you want the values to propagate to any subfolders, check the Propagate these default meta-
data values to subfolders box.
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6. To configure the behavior or the prompt to record document properties, choose a radio button on
the right under the When adding documents, prompt for properties section:
o Always
o Never
e According to application global settings
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